User Interface Standards and Guidelines

Applicable Releases:
SAP Business One 8.8, 8.81 and 8.82

All Countries
English
July 2011
# Table of Contents

1. Overview ............................................................................................................................... 5

2. General Issues .......................................................................................................................... 6
   2.1 About This Document ...................................................................................................... 6
   2.2 Selecting Skin Style ......................................................................................................... 6

3. SAP Business One Structure ................................................................................................ 7
   3.1 The Main Window ............................................................................................................ 7
   3.2 Main Menu ....................................................................................................................... 8

4. GUI Controls .......................................................................................................................... 12
   4.1 Control Overview ........................................................................................................... 12
   4.2 Basic Data Controls ....................................................................................................... 13
      4.2.1 Text Field ........................................................................................................... 13
   4.3 Basic Selection Controls ............................................................................................... 16
      4.3.1 Checkbox ........................................................................................................... 16
      4.3.2 Checkbox with Three States ............................................................................. 17
      4.3.3 Radio Button ...................................................................................................... 18
      4.3.4 List Box .............................................................................................................. 20
      4.3.5 Pickers ............................................................................................................... 23
      4.3.6 Choose from List (List of <list type>) ................................................................. 25
      4.3.7 Choose from Tree .............................................................................................. 28
   4.4 Buttons ........................................................................................................................... 30
      4.4.1 Command Button ............................................................................................... 30
      4.4.2 List Box Button .................................................................................................. 32
      4.4.3 Back Arrow Icon ................................................................................................ 34
      4.4.4 Graph Icon ......................................................................................................... 36
      4.4.5 Insert Image and Clear Image Icons ................................................................. 39
      4.4.6 Link Arrow Icon .................................................................................................. 40
   4.5 Complex Data Controls ................................................................................................... 43
      4.5.1 Table .................................................................................................................. 43
      4.5.2 Hierarchical Table .............................................................................................. 53
      4.5.3 Row Types ......................................................................................................... 55
      4.5.4 Tree Control ....................................................................................................... 57
      4.5.5 Tree-Table Control ............................................................................................ 58
   4.6 Advanced Selection Controls ......................................................................................... 61
      4.6.1 Account Selector ............................................................................................... 61
      4.6.2 Business Partner and Item Selectors ................................................................ 63
      4.6.3 Date Range Selector ......................................................................................... 68
      4.6.4 Extended Checkbox .......................................................................................... 68
<table>
<thead>
<tr>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.7 View Controls</td>
</tr>
<tr>
<td>4.7.1 Tab Strip</td>
</tr>
<tr>
<td>4.7.2 Nested Tab Strip</td>
</tr>
<tr>
<td>4.7.3 Drawers</td>
</tr>
<tr>
<td>4.8 Window Controls</td>
</tr>
<tr>
<td>4.8.1 Window Title Bar</td>
</tr>
<tr>
<td>4.8.2 Menu Bar and Dropdown Menus</td>
</tr>
<tr>
<td>4.8.3 Context Menu (Right-Click Menu)</td>
</tr>
<tr>
<td>4.8.4 Toolbar</td>
</tr>
<tr>
<td>4.8.5 Window Scroll Bar</td>
</tr>
<tr>
<td>4.8.6 Tooltip</td>
</tr>
<tr>
<td>4.8.7 Status Bar</td>
</tr>
<tr>
<td>5. Graphic Design Guidelines</td>
</tr>
<tr>
<td>5.1 Screen Resolution</td>
</tr>
<tr>
<td>5.2 Fonts</td>
</tr>
<tr>
<td>5.3 Window Layout</td>
</tr>
<tr>
<td>5.4 Terminology</td>
</tr>
<tr>
<td>5.5 Labeling Conventions</td>
</tr>
<tr>
<td>5.6 Command Buttons</td>
</tr>
<tr>
<td>5.7 Arranging the Information in a Window</td>
</tr>
<tr>
<td>6. Typical Screens</td>
</tr>
<tr>
<td>6.1 Add/Find Window</td>
</tr>
<tr>
<td>6.2 List of Values Window (List of &lt;List Type&gt;)</td>
</tr>
<tr>
<td>6.3 Compound Text Field</td>
</tr>
<tr>
<td>6.4 Choose from Tree Window</td>
</tr>
<tr>
<td>6.5 Date Selection Window</td>
</tr>
<tr>
<td>6.6 Calculator Window</td>
</tr>
<tr>
<td>6.7 Filter Table Window</td>
</tr>
<tr>
<td>6.8 Sort Table Window</td>
</tr>
<tr>
<td>6.9 Setup Window (NOE = New Object Entry)</td>
</tr>
<tr>
<td>6.10 Form Settings</td>
</tr>
<tr>
<td>6.11 Row Details</td>
</tr>
<tr>
<td>6.12 System Messages and Message Window</td>
</tr>
<tr>
<td>6.13 Print Options Messages</td>
</tr>
<tr>
<td>6.14 Report Window</td>
</tr>
<tr>
<td>6.14.1 Hierarchical Reports</td>
</tr>
<tr>
<td>6.15 Selection Criteria Window</td>
</tr>
<tr>
<td>6.16 Wizard</td>
</tr>
<tr>
<td>7. Adding a New Feature</td>
</tr>
</tbody>
</table>
1. Overview

The User Interface Standards and Guidelines document provides best practices for designing the SAP Business One interface. This document describes the structure and look of the interface, and the rules used to perform the actions that affect the system.

By following these guidelines, developers, partners, and product managers can improve the quality and consistency of the application.

The document offers the most updated and advanced GUI design rules and recommendations. It also includes a host of relevant GUI information, including a glossary, case studies, reusable components, and international support standards.

To achieve the desired level of consistency, usability, and functionality, and to maintain a high level of quality in the product, you must take into account all the relevant aspects described in this document.
2. General Issues

2.1 About This Document

- This document presents guidelines for achieving the desired interface.
- Position and direction guidelines in this document refer to left-to-right languages. If you are using a right-to-left language, invert the directions. Those guidelines are also valid for field alignment in SAP Business One.
- All font sizes and colors described in the document are the defaults for the SAP Signature Design skin style.
- All the graphics in this document are supported by the application. SAP Business One supports the following graphic file extensions: *.JPG, *.GIF, *.PNG.

2.2 Selecting Skin Style

SAP Business One lets you choose between two different skin styles for the graphic interface of the application: Classic and SAP Signature Design. The default style is SAP Signature Design.

To operate SAP Business One with the skin style used in releases prior to 8.8, proceed as follows:

1. From the SAP Business One Main Menu, choose Administration → System Initialization → General Settings → Display tab.
2. From the Skin Style dropdown list, select Classic.
3. To apply your changes, choose the Update button.

Note

3. SAP Business One Structure

SAP Business One is structured with three basic types of windows:

- The main window
- Primary and subordinate windows (forms)
- Message boxes

The SAP Business One main window contains all the major functions of the application and serves as the central place for initiating SAP Business One activity.

The primary windows are for entering additional data, making choices, or performing actions. The control elements are placed in the work area of the various windows to perform specific tasks or functions. Some elements serve as basic window handling properties, such as the minimize, maximize and close icons. Other elements are specific to SAP Business One, such as the back arrow and link arrow icons, tables, and different advanced selection controls.

Subordinate windows appear as a result of user actions or to supplement a primary window. There may be simultaneous subordinate windows open, but you can perform actions only in the active window/form at any given time.

Message boxes inform you of errors or consequences of actions.

3.1 The Main Window

SAP Business One opens with the main window displaying the following components:

- Main Menu
- Menu bar
- Toolbar
- Pull-down menus
- Status bars
The following components appear in the SAP Business One main window when working with the application:

- Main Menu
- Menu options
- Submenus
- Forms (sub windows)

### 3.2 Main Menu

The **Main Menu** can also be accessed by the **Window** menu in the menu bar and choosing **Main Menu**, or by using the shortcut **CTRL+O**.

The **Main Menu** offers three principal modes for working with the application. Each mode is located on its own tab:

- Modules
- Drag & Relate
- My Menu
Main Module

- Module items are left aligned.
- Each module is framed by two border lines: border-top (#1B2C54) and border-bottom (#466BBB)
- The background color of the module is #3A5CAA
- Each module has a representative icon
- Icons are centered one above the other
- The maximum for icon height and width is 16 pixels
The look of each module depends on its state:

<table>
<thead>
<tr>
<th>State</th>
<th>Specification</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular</td>
<td>Font color – white Font &amp; size – Tahoma bold 8</td>
<td><img src="image" alt="Sales Opportunities" /></td>
</tr>
<tr>
<td>Rollover</td>
<td>Font color – white Font &amp; size – Tahoma bold 8 Strip Color – light blue (#3C76C5)</td>
<td><img src="image" alt="Business Partners" />, <img src="image" alt="Banking" />, <img src="image" alt="Inventory" /></td>
</tr>
<tr>
<td>Selected Module</td>
<td>Font color – white Font &amp; size – Tahoma bold 8 Strip color –</td>
<td><img src="image" alt="Banking" /></td>
</tr>
</tbody>
</table>

The look of each submenu depends on its state:

<table>
<thead>
<tr>
<th>State</th>
<th>Specification</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular</td>
<td>Font color – white Font &amp; size – Tahoma regular 8</td>
<td><img src="image" alt="Financials" /></td>
</tr>
<tr>
<td>Opened</td>
<td>Font color – white Font &amp; size – Tahoma regular 8 Icon changes to</td>
<td><img src="image" alt="Sales Opportunities" /></td>
</tr>
<tr>
<td>Rollover</td>
<td>Font color – white Font &amp; size – Tahoma regular 8 Frame color – dark blue (#3E63B8)</td>
<td><img src="image" alt="Business Partners" /></td>
</tr>
</tbody>
</table>

The three types of menu items are: Window, Report and Query.

The look of each menu item depends on its state:

<table>
<thead>
<tr>
<th>State</th>
<th>Specification</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular Window</td>
<td>Font color – white Font &amp; size – Tahoma regular 8</td>
<td><img src="image" alt="Deposit" /></td>
</tr>
<tr>
<td>Regular Report</td>
<td>Font color – white Font &amp; size – Tahoma regular 8</td>
<td><img src="image" alt="Open Items List" /></td>
</tr>
<tr>
<td>Regular Query</td>
<td>Font color – white Font &amp; size – Tahoma regular 8</td>
<td><img src="image" alt="Customers Credit Limit Deviation" /></td>
</tr>
</tbody>
</table>
### Guidelines for Adding Menu Items

- Place items according to the hierarchic structure within a respective module.
- Position the menu item after considering the following:
  - How frequently is it used? Frequently used items should be placed before less frequently used ones.
  - Where is it used in the work flow? Items that are logically successive to other items should be placed directly below them.
- **Setup** windows are located in the *Administration* module, in the *Setup* subfolder of each relevant module.
- Every module contains its respective reports. In addition, all reports are also located in the *Reports* module.
- Queries are located within the respective module, in the *Reports* section.
- Note that the *Main Menu* appears in a closely related form in the *Modules* pull-down menu, the *Authorizations* window, the *Drag & Relate* menu, and the *User-Defined Fields - Management* window.

For details regarding the main window components, see: [Toolbar](#), [Status Bar](#), [Menu Bar and Dropdown Menus](#).
4. GUI Controls

4.1 Control Overview

Controls in SAP Business One have the following characteristics:

- You can access many controls via a keyboard shortcut (mnemonic). You implement the shortcut by underlining one of the letters in a control label. Pressing Alt+<mnemonic> is equivalent to clicking the control. The shortcut should be unique within the window. Since there are more functions that need shortcuts than there are keys on the keyboard, some of the functions are not implemented in the application.

- You should assign each control with two information types:
  - *Tooltip*: Briefly informative text displayed in the status bar when you mouse over the control.
  - *System Information* (formerly known as *Debug Information*): Additional internal information displayed in the status bar if the *View System Information* option is enabled. This information may be used by developers, QA, and SAP Support.

The controls in this section are organized by type:

<table>
<thead>
<tr>
<th>Control Type</th>
<th>UI Element</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic Data Controls</strong></td>
<td>Text field</td>
</tr>
<tr>
<td><strong>Basic Selection Controls</strong></td>
<td>Checkbox</td>
</tr>
<tr>
<td></td>
<td>Checkbox with Three States</td>
</tr>
<tr>
<td></td>
<td>Radio button</td>
</tr>
<tr>
<td></td>
<td>List Box</td>
</tr>
<tr>
<td></td>
<td>Pickers</td>
</tr>
<tr>
<td></td>
<td>Choose from List (List of &lt;type&gt;)</td>
</tr>
<tr>
<td></td>
<td>Choose From Tree</td>
</tr>
<tr>
<td><strong>Buttons</strong></td>
<td>Command Button</td>
</tr>
<tr>
<td></td>
<td>List Box Button</td>
</tr>
<tr>
<td></td>
<td>Back Arrow Icon</td>
</tr>
<tr>
<td></td>
<td>Graph Icon</td>
</tr>
<tr>
<td></td>
<td>Insert Image and Clear Image Icons</td>
</tr>
<tr>
<td></td>
<td>Link Arrow Icon</td>
</tr>
<tr>
<td><strong>Complex Data Controls</strong></td>
<td>Table</td>
</tr>
<tr>
<td></td>
<td>Hierarchical Table</td>
</tr>
<tr>
<td></td>
<td>Table – Row Types</td>
</tr>
<tr>
<td></td>
<td>Tree Control</td>
</tr>
<tr>
<td></td>
<td>Tree-Table control</td>
</tr>
</tbody>
</table>
### 4.2 Basic Data Controls

#### 4.2.1 Text Field

Usage Example: Business Partners → Business Partners Master Data.

**When to use?**

Text fields are used for displaying or entering a single data value.

**General Description**

- The format of the data to be entered may be textual, numeric, currency and so on
- A text field may be in one of two modes:
  - Enabled: Allows the user to specify a value
  - Disabled: Displays a value, but does not allow user entry
- When the user moves to the next field, the application performs validity checks. The entered value is checked against the required format of the field, in addition to any other specific constraints that may exist for this field.
- Text field labels are part of the control. A text field must have a label, which helps identify the purpose of the text field and provides a means of indicating when the field is disabled.
- If the field contains text that is longer than the field length, a tooltip is dynamically added to the field, displaying the full text (for information, see Tooltip).
Visual Specifications

- Field Shape: Rectangular box, with a single row (1 pixel wide) frame
- Field Size: Height = 14 pixels; Width – depends on the field content, and the size of the adjacent field (for information on field sizes, see Window Layout)
- A white row connects the label to the field (for information on labels, see Labeling Conventions)

<table>
<thead>
<tr>
<th>Mode</th>
<th>Specification</th>
</tr>
</thead>
</table>
| Normal (write enabled) | Box color: white ; Frame color: #B6B9BA  
|                     | customer:                                           |
| Read only           | Box color: #D9E5F2; Frame color: #B6B9BA   
|                     | customer                                            |
| Field in focus      | Box color: #FEF09E; Frame color: #B6B9BA  
|                     | customer1                                           |

- Color Specifications:

  - The text color is black. Selected text color is white, with Microsoft Windows selection color as background
  - The description text of every field should contain a short description of the field, and any additional information, such as format or constraints

  **Example**
  - Discount (Numeric 19.6): Specifies the number of digits and decimal points
  - Customer Code (15 characters)
  - Document Number (Number between 1 and 1000)
  - Document Date (Date)

- Text alignment within the field should be adjusted to the field type. Textual data should be left-aligned, while numerical fields should be right-aligned.

  **Note**
  Numerical fields may contain non-numeric characters, for example, a price field contains the currency, such as USD 100.00; but they are still considered as numbers and should be right-aligned.

GUI Attributes

Consider the following attributes when creating a text field:

- Label
- Data format: text, numeric, date, currency, and so on
- Alignment: left or right
- Functionality: read, or read + write
- Constraints (optional, for example: numeric, alpha-numeric)
• Maximal input length
• Default value (optional)
• Description text
• System information
• Tooltip (added dynamically): A tooltip provides a small pop-up window with descriptive text, for a control or graphic object.

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>Rollover refers to the effect created in the appearance of a graphical element when the mouse moves over it.</td>
</tr>
<tr>
<td></td>
<td>The field’s Description Text is displayed in the status bar. If the field is shorter than the text it contains, a tooltip is displayed to show the full text.</td>
</tr>
<tr>
<td>Click in field</td>
<td>The field color changes to yellow. The Description Text is displayed in the status bar.</td>
</tr>
<tr>
<td></td>
<td>If the field is empty, the text cursor is placed at the beginning of the field.</td>
</tr>
<tr>
<td></td>
<td>If the field already contains text, the text is selected (displayed as white text over dark-blue background).</td>
</tr>
<tr>
<td>Double-click in field</td>
<td>Selects the word at the mouse position</td>
</tr>
<tr>
<td>Type in field</td>
<td>Typing replaces any selected text. If no text is selected, typed characters are inserted at the cursor position.</td>
</tr>
<tr>
<td></td>
<td>If the typed-in text is longer than the visual field, the field’s text is scrolled to the left, so that the current entry point is visible. In case of a long text, a tooltip is dynamically added to the field, displaying the full text of the field.</td>
</tr>
<tr>
<td></td>
<td>If the text length reaches the maximal input length, no typing is allowed (no response to typed-in keys), and an error message is displayed in the status bar.</td>
</tr>
<tr>
<td>Exit field</td>
<td>A validity check is performed, comparing the field data with the required format and constraints.</td>
</tr>
<tr>
<td></td>
<td>If errors are found, a message is displayed in the status bar. The cursor remains in the field.</td>
</tr>
<tr>
<td></td>
<td>If no errors are found, the field color goes back to normal.</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts

The field conforms to standard Microsoft Windows text entry conventions:

- **Backspace** and **Delete** erase one character to the left or to the right of the cursor position.
- **Left/Right** arrow keys move the cursor one position to the left/right. If the text length is longer than the visual field, clicking the left/right arrow at the left/right edge of the field scrolls the text to the required direction.
- **Shift + Left/Right** arrow selects the text along the cursor movement.
- **Home/End** moves the cursor to the beginning or to the end of the text, respectively.

4.3 Basic Selection Controls

4.3.1 Checkbox

Usage Example: *Business Partners → Activity.*

When to use?

- The options are either ON or OFF.
- Both states of the selection are unambiguously opposite to each other.
- When multiple selections are required, use as one checkbox for each option.

General Description

- Checkboxes support options that are either ON or OFF.
- A checkbox supports two modes:
  - Selected (ON): Allows the user to select a value or operation.
  - Deselected (OFF): Displays a value or operation, but with no user selection.
- When the checkbox is selected, the box displays a check mark; otherwise, the checkbox is empty.
- A checkbox appears as a square box with an accompanying label.
- A group of checkboxes, unlike radio buttons, enables multiple selections.

Visual Specifications

- Use this shape: 
  - Selected
  - Deselected
- Size: 14x14 pixels.
- The label is placed 4 pixels to the right of the box. For information about labels, see **Labeling Conventions**.
• One of the letters in the label might be underlined. This letter is used as a mnemonic for the checkbox. Typing $\text{Alt} + \langle\text{mnemonic}\rangle$ is equivalent to clicking the checkbox. The mnemonic should be unique within the window.

• Colors:

<table>
<thead>
<tr>
<th>State</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Text color – black</td>
</tr>
<tr>
<td></td>
<td>□ Max. Cash Discount</td>
</tr>
<tr>
<td>Disabled</td>
<td>Text color – #999999</td>
</tr>
<tr>
<td></td>
<td>□ Display Credit Balance with Negative Sign</td>
</tr>
<tr>
<td></td>
<td>□ Use Segmentation Accounts</td>
</tr>
</tbody>
</table>

GUI Attributes

Consider the following attributes when creating a checkbox:

• Label
• Mnemonic
• Functionality: read, or read + write
• Default value (optional)
• Description text
• System information

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The checkbox Description Text is displayed in the status bar</td>
</tr>
<tr>
<td>Click the checkbox</td>
<td>The checkbox toggles its state</td>
</tr>
<tr>
<td>Click the checkbox label</td>
<td>The checkbox toggles its state</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts

$\text{Alt} + \langle\text{underlined letter}\rangle$ toggles the checkbox state.

4.3.2 Checkbox with Three States

Usage Example: In the Print Layout Designer, when you select multiple fields, the Properties window shows the third (ambiguous) state, in case not all selected fields have the same value for a specific checkbox.
When to use?

Checkboxes with 3-state support are ON, OFF, or AMBIGUOUS. Use this control to support the ambiguous state.

General Description

- When a checkbox represents the state of several objects, some of which are ON, while others are OFF, the third state is AMBIGUOUS.
- When a checkbox in the ambiguous state is clicked, it toggles between two states: ON and OFF. In this situation, we recommend that the checkbox alternate between the three states: ON, OFF and then back to AMBIGUOUS.

Visual Specifications

- Use this shape: 
  - Selected
  - Deselected
  - Ambiguous
- For all other visual specifications, see Checkbox

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The checkbox Description Text is displayed in the status bar</td>
</tr>
<tr>
<td>Click the checkbox in the ON or OFF state</td>
<td>The checkbox toggles its state from ON to OFF and vice versa.</td>
</tr>
<tr>
<td>Click the checkbox in the Ambiguous state</td>
<td>The checkbox toggles its state from ON to OFF and vice versa. (The checkbox should rotate among the three states: ON, OFF and then back to AMBIGUOUS).</td>
</tr>
<tr>
<td>Click the checkbox label</td>
<td>The checkbox toggles its state from ON to OFF and vice versa.</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts

Alt+<underlined letter> toggles the checkbox state.

4.3.3 Radio Button

![Monthly Report](image1) ![Annual Report](image2)

Usage Example: Sales A/R → Sales Reports → Sales Analysis.

When to use?

Use radio buttons to represent a set of mutually exclusive choices for a particular property or action.

Note

To allow selection of multiple options, use a checkbox instead.
General Description

- A radio button represents a single choice within a group of at least two radio buttons.
- Only one option can be set
- A radio button appears as a small circle. When selected, it displays a dot in the middle of the circle; otherwise, the circle is empty
- The user clicks one of the radio buttons to select it, which deselects the others in the group
- A radio button may be in one of two modes:
  - Selected: Shows the selected value or operation.
  - Deselected: Used only to display the deselected value or operation

Note

A list box may be used as an alternative to radio buttons, especially when the space is limited.

Visual Specifications

- Use this shape: ![Selected](image) ![Deselected](image)
- Button size: 14x14 pixels
- Place the label 5 pixels to the right of the box. For more information about labels, see Labeling Conventions
- One of the letters in the label might be underlined. This letter is used as a mnemonic for this radio button. Typing `Alt+<mnemonic>` is equivalent to clicking the radio button. The mnemonic should be unique within the window.
- Group Label: You may add a group label to the left of the uppermost radio button as a general explanation of their purpose
- Arrange the radio buttons vertically (one below the other) or horizontally (one next to the other). Use the horizontal arrangement only when there is no room for the preferred vertical arrangement, and when the group comprises of all relevant radio buttons.

GUI Attributes

Consider the following attributes when creating a radio button group:

- Label for each button
- Mnemonic for each button
- Group label
- Default value. Note that one of the buttons in the group should be selected by default.
- Description text for each button
- System information for each button
Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The radio button description text is displayed in the status bar</td>
</tr>
<tr>
<td>Click the radio button</td>
<td>The radio button is selected. All other radio buttons in the group are deselected.</td>
</tr>
<tr>
<td></td>
<td>A dot appears in the circle. The label is displayed in the status bar (see Status Bar).</td>
</tr>
<tr>
<td>Click the radio button</td>
<td>The radio button is selected. All other radio buttons in the group are deselected.</td>
</tr>
<tr>
<td>label</td>
<td>A dot appears in the circle. The label is displayed in the status bar (see Status Bar).</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts

Alt+<underlined letter> selects the radio button and deselects all other radio buttons in its group.

4.3.4 List Box

Usage Example: Inventory → Item Master Data.

When to use?

- When the user needs to select one value from the list
- When the potential value list is short, usually up to 20 values
- When the user selection can be based on the value name alone
- See also: Choose from List

General Description

- A list box displays a relatively small number of choices that vary in number or content
- It allows the user to click an enabled field and retrieve a value for it from the displayed list
- Lists that may be extended contain a Define New option, allowing the user to define additional values
- Manual data entry is not supported in this field
- If the field contains text that is longer than the field length, a tooltip is dynamically added to the field, displaying the full text.

Visual Specifications

- Field Shape: Same as text field, plus the symbol to the right of the field
- Field Size: Height = 14 pixels; Width – depends on the field content, and the size of the adjacent field (for information about field sizes, see Window Layout)

- A white row connects the label to the field. For information about labels, see Labeling Conventions

<table>
<thead>
<tr>
<th>Mode</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal (enabled)</td>
<td>Box color: white; Frame color: #B6B9BA</td>
</tr>
<tr>
<td></td>
<td>Serial Numbers</td>
</tr>
<tr>
<td>Read only</td>
<td>Box color: #D9E5F2; Frame color: #B6B9BA</td>
</tr>
<tr>
<td></td>
<td>The list symbol ▼ does not appear when the field is disabled.</td>
</tr>
<tr>
<td>Field in focus</td>
<td>Box color: #FEF09E; Frame color: #B6B9BA</td>
</tr>
<tr>
<td></td>
<td>Serial Numbers</td>
</tr>
</tbody>
</table>

List is open
- The value list is displayed under the field.
  - The list background color is white.
  - The list border is black, 1-pixel wide.
  - Each value in the list occupies a strip 16 pixels high.
  - The strip of a highlighted value is dark yellow (#FCDD82).
  - If the list is longer than 10 values, a scrollbar is added at the right side of the list.
Text color is black. Selected text is white, with the Microsoft Windows selection color in the background.

If the field does not have a default value, the first value in the list is an empty row.

Selecting *Define New* in the list opens a window for adding list values.

### GUI Attributes

Consider the following attributes when creating a list box:

- Label
- List of values
- Alignment (left/right)
- Functionality: read, or read + write
- Can the list be defined by the user: Yes/No
- Default value (optional)
- Description text
- System information
- Tooltip text (added dynamically)

### Functional Specifications

#### Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The list box description text is displayed in the status bar. If the list box is shorter than the text it contains, a tooltip is displayed to show the full text.</td>
</tr>
<tr>
<td>Click the field</td>
<td>The field color changes to yellow. The list is displayed. If the field already contains a value, this value is highlighted; otherwise, the first list value is highlighted.</td>
</tr>
<tr>
<td>Click the field when the list is displayed</td>
<td>The list is closed.</td>
</tr>
<tr>
<td>Select an value in the list</td>
<td>The list is closed. The selected value appears in the field.</td>
</tr>
<tr>
<td>Select an empty row in the list.</td>
<td>The list is closed. The field is cleared.</td>
</tr>
<tr>
<td>Type a letter when the list is open</td>
<td>The list is scrolled to the first value starting with this letter</td>
</tr>
<tr>
<td>Select <em>Define New</em> in the list</td>
<td>The list is closed. A setup window is displayed. After the new value is added, it appears in the field.</td>
</tr>
<tr>
<td>Exit field</td>
<td>The field returns to its usual color</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts

- Down arrow opens the list
- Up/Down arrows: When the list is open, highlights the next/previous value in the list
- Enter closes the list and copies the highlighted value to the field

4.3.5 Pickers

Usage Example: Sales A/R → Sales Quotation.

When to use?

When the user wants to select a value from a list or date selection window, or calculate a number:

- Date Picker – to select a date
- List of Values Picker – to select from a list
- User-Defined Fields List Picker – to select from a list defined by the user
- Calculator Picker – to calculate and enter the value
- Translation Picker – to select from several translation options (as long the company was defined as a Multi-Language company)

Note

When more than one picker is defined for the same field, then the List of User-Defined Values is the one that is presented.

General Description

A picker is an icon located inside a field or a table cell. It becomes visible when the cursor is located within the field. It enables the user to pick a value and return it to the field.

- Only one picker per cell
- When more than one picker is required, only the List of User-Defined Fields picker is shown.
- When a list of values is defined for a specific field, the Picker operates in the same way the Tab key does.
- A user can enable/disable the pickers in the View → Pickers Display upper menu entry.
- Each picker has an indicator.

An indicator is an icon located inside a field/cell that signals when a picker is available for that field/cell.

- The List, List of User-Defined Values, and Translation pickers have an indicator. The date and calculator pickers do not have an indicator.
- Users can enable/disable indicators in the View → Indicators Display upper menu entry.
- In a grid, indicators appear on the title and not in each cell.
- When there is more than one indicator to present in a specific cell, all indicators appear one after the other.
- The Translation indicator also indicates when a value has already been entered.
To see the translation pickers, you need to select the *Multi-Language Support* checkbox in the *Company Details* window.

**Visual Specifications**

- Pickers: A picker has two states, each represented by a different icon: regular and pressed
- Indicators: Each indicator has an icon. The indicator appears in fields and on table headers

**Pickers**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Picker Regular</td>
<td><img src="image1" alt="Date Picker Regular" /></td>
</tr>
<tr>
<td>Date Picker Pressed</td>
<td><img src="image2" alt="Date Picker Pressed" /></td>
</tr>
<tr>
<td>List of Values Picker Regular</td>
<td><img src="image3" alt="List of Values Picker Regular" /></td>
</tr>
<tr>
<td>List of Values Picker Pressed</td>
<td><img src="image4" alt="List of Values Picker Pressed" /></td>
</tr>
<tr>
<td>User Defined Values List Picker Regular</td>
<td><img src="image5" alt="User Defined Values List Picker Regular" /></td>
</tr>
<tr>
<td>User Defined Values List Picker Pressed</td>
<td><img src="image6" alt="User Defined Values List Picker Pressed" /></td>
</tr>
<tr>
<td>Calculator Picker Regular</td>
<td><img src="image7" alt="Calculator Picker Regular" /></td>
</tr>
<tr>
<td>Calculator Picker Pressed</td>
<td><img src="image8" alt="Calculator Picker Pressed" /></td>
</tr>
<tr>
<td>Translation Picker Regular (with value)</td>
<td><img src="image9" alt="Translation Picker Regular (with value)" /></td>
</tr>
<tr>
<td>Translation Picker Pressed (with value)</td>
<td><img src="image10" alt="Translation Picker Pressed (with value)" /></td>
</tr>
<tr>
<td>Translation Picker Regular (without value)</td>
<td><img src="image11" alt="Translation Picker Regular (without value)" /></td>
</tr>
<tr>
<td>Translation Picker Pressed (without value)</td>
<td><img src="image12" alt="Translation Picker Pressed (without value)" /></td>
</tr>
</tbody>
</table>

**Indicators**

<table>
<thead>
<tr>
<th>Mode</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Indicator</td>
<td><img src="image13" alt="System Indicator" /></td>
</tr>
<tr>
<td>User Defined Values List Indicator</td>
<td><img src="image14" alt="User Defined Values List Indicator" /></td>
</tr>
<tr>
<td>Translation Indicator (with value)</td>
<td><img src="image15" alt="Translation Indicator (with value)" /></td>
</tr>
<tr>
<td>Translation Indicator (without value)</td>
<td><img src="image16" alt="Translation Indicator (without value)" /></td>
</tr>
</tbody>
</table>

**GUI Attributes**

Consider the following attributes when creating a picker:

- Alignment (left/right)
- Is the field editable: Yes/No (if No - no picker can be available)
- Default value (for translation - if the value was translated, Yes/No)
- Static tooltip text
• Target tooltip text

Consider the following attributes when creating an indicator:

• Alignment (left/right)
• Is the field editable: Yes/No (if No - no indicator can be available)
• Default value (for translation - if the value was translated, Yes/No)
• Static tooltip text
• Target tooltip text

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click the picker</td>
<td>The icon changes to ‘pressed’ and its window is opened.</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts

• Date Picker: Ctrl+Shift+D
• Calculator: Ctrl+Shift+C
• User Defined Values: Shift+F2
• List of Values: Tab/Shift+Tab

Note

The List of Values picker behaves exactly like the Tab/Shift+Tab option except for one differentiation: If the user enters a valid value in the field and then clicks the picker, the Choose from list opens with all values. The Tab key brings the cursor to the next field.

4.3.6 Choose from List (List of <list type>)

Usage Example: Sales A/R → Sales Quotation.

This control is built from multiple controls.

When to use?

• When the user must select one value from a list
• When the potential value list is long, more than 20 values. For a potentially short value list, it is recommended to use a list box (see List Box)
• When the user selection requires additional information (other than the item name)
Note

If in certain situations it is preferable to create a combination of a list box and a List of Values field, a list of values icon is attached to the field:

Use this combination when the potential number of items in the list may change. For example, a list defined by the user may be small at first, but grows significantly over time.

General Description

- The control allows the user to select a value from a list of values that appear in the List of Values window
- This control is a combination of a text field and the List of Values Picker / Indicator
- The user may type a value in the field
- The caption of the window is 'List of <list type>', according to the chosen list type (Business Partners, Item, and so on)
- To prevent free text input by the user, disable the field and provide only the List of Values picker
- Some lists can be defined or extended by the user. For such a list, the user is allowed to add items to the list from the List of Values window.

Visual Specifications

- Field Shape: Same as text field, plus an icon attached to the right side of the field
- Field size: Height = 14 pixels. Width varies, depending on the field content and the size of adjacent fields (for information about field sizes, see Window Layout)
- A white line connects the label to the field (for information about labels, see Labeling Conventions)
- Colors:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal (enabled)</td>
<td>Box color - white, Frame color – #B6B9BA</td>
</tr>
<tr>
<td></td>
<td>Indicator can be visible/not visible.</td>
</tr>
<tr>
<td></td>
<td>GL/Acct/BP Codes From</td>
</tr>
<tr>
<td></td>
<td>Date From</td>
</tr>
<tr>
<td>Select Only</td>
<td>Box color – #D9E5F2, Frame color – #B6B9BA</td>
</tr>
<tr>
<td></td>
<td>BP Channel Name</td>
</tr>
<tr>
<td>Field in focus</td>
<td>Box color – #FEF09E, Frame color – #B6B9BA</td>
</tr>
<tr>
<td></td>
<td>Picker is shown</td>
</tr>
<tr>
<td></td>
<td>Customer</td>
</tr>
<tr>
<td>List button is selected</td>
<td>The picker graphic changes to look selected</td>
</tr>
</tbody>
</table>
• Text color is black. When selected, it is white, with Microsoft Windows selection color in the background

• A tooltip is attached to the icon (for information about tooltip content, see Tooltip). The tooltip should display:
  o Row 1 – Static tooltip: Choose from List
  o Row 2 – Target tooltip: Name of a list form that this button opens by (Dynamic Name)

GUI Attributes
Consider the following attributes when creating a Choose from List control:
• Label
• List of values
• Alignment (left/right)
• Functionality: read, or read + write
• Is the field editable: Yes/No
• Can the list be defined by the user: Yes/No
• Default value (optional)
• Description text
• System information
• Static tooltip text
• Target tooltip text

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The description text is displayed in the status bar</td>
</tr>
<tr>
<td>Icon Rollover</td>
<td>A tooltip is displayed</td>
</tr>
<tr>
<td>Click the field</td>
<td>The field color changes to yellow. A picker is displayed in the Field</td>
</tr>
<tr>
<td>Click the List of Values picker</td>
<td>The picker changes to the chosen display.</td>
</tr>
<tr>
<td>Move to the next field when the field is empty (and was defined as mandatory)</td>
<td>The List of Values window is displayed.</td>
</tr>
<tr>
<td></td>
<td>After the user selects a value, the window closes and the selected value is displayed in the field.</td>
</tr>
</tbody>
</table>
User Interface Standard and Guidelines

User Action | System Response
---|---
Move to the next field when the field is being typed in | A validity check is performed to verify that the value in the field is one of the values in the list. Yes: The field reverts to its usual appearance and the focus moves to another field. No: The Select from List window is displayed.

**Note**
The Tab key is interpreted as an attempt to move to another field. A quick way to display the list is to place the cursor in the field, then press Tab to display the list.

### Keyboard Shortcuts
- All keys used to edit a text field are valid here too
- When Tab is pressed in an empty field, it displays the List of Values window
- It is possible to connect two List of Values windows to a field. In such a case one of them is opened with a Tab while the other is opened with Ctrl+Tab

### 4.3.7 Choose from Tree

![Image of Choose from Tree](image)

Usage Example: Business Partners → Business Partners Master Data → Payment System tab.

**Note**
This control is built from multiple controls.

### When to use?
- When a group of fields is related to each other in a hierarchical relation
- When the user is allowed to fill each field individually, but a shortcut for selecting the whole group at once is required

### General Description
- This control is implemented by a group of fields. Each field is either a text field or a list box control
- The fields are organized top-down, illustrating the hierarchical relations between them, for example, Country → Bank → Branch → Account No
- Choosing a value for a field narrows the available options for the field below it, as only values that match the hierarchy may be chosen. For example, after a bank is chosen, the Branch list box contains only branches that belong to this bank.
• The Choose from Tree icon is used to open the Choose from Tree window, which displays the whole hierarchical structure and lets the user select a node.

• Once a node is selected, the relevant field is filled with the chosen value, and all its ancestors are filled in accordingly. For example, selecting a branch causes the appropriate bank and country fields to be filled automatically.

Visual Specifications

• Each field, depending on its type, has the attributes of a text field or a list box control.

• In addition, the Choose from Tree icon is located to the right of the uppermost field:

• A tooltip appears together with the icon (for more information, see Tooltip). The tooltip should display:
  o Row 1 – Static Tooltip: Choose From Tree
  o Row 2 – Target Tooltip: Name of form that opens when you click the icon (dynamic name)

GUI Attributes

Depending on the field type, it has the attributes of a text field or a list box control. Text field attributes include:

• Label
• Data format (text, numeric, date, currency, and so on)
• Alignment: left/right
• Functionality: read, or read + write
• Constraints (optional, for example: numeric, alpha-numeric)
• Maximal input length
• Default value (optional)
• Description text
• System information
• Tooltip (added dynamically)

List box attributes include:

• Label
• List of values
• Alignment (left/right)
• Functionality: read, or read + write
• Can the list be defined by the user: Yes/No
• Default value (optional)
• Description text
• System information
• Tooltip text (added dynamically)

Additional Attributes:
• Tooltip text on the Choose from Tree icon

**Functional Specifications**

**Operation Procedure**

In addition to the operational procedure of each individual field (see Text Field or List Box):

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection of a value in a field</td>
<td>The list of potential values in lower fields is narrowed down to conform to the hierarchical relations.</td>
</tr>
<tr>
<td>Rollover</td>
<td>A tooltip is displayed</td>
</tr>
<tr>
<td>Click the Choose from Tree icon</td>
<td>While the left mouse button is pressed, the button changes to the following shape: <img src="image.png" alt="tooltip" /></td>
</tr>
<tr>
<td></td>
<td>The Choose from Tree window is displayed. The value chosen in the window defines a path of values, starting from the root of the tree down to the leaf. These values are displayed in the corresponding fields.</td>
</tr>
</tbody>
</table>

**Keyboard Shortcuts**

None

### 4.4 Buttons

#### 4.4.1 Command Button

**When to use?**

To perform user actions, such as open/close a window, save data, display additional information, perform a calculation, and so on.

**General Description**

• A command button is a rectangular control with a label that represents the action the button triggers

• The user chooses the button to perform the action

• When the user chooses the button, the input focus moves to the command button, the button display changes to its selected appearance. If the user moves the mouse pointer off the command button while the mouse button remains pressed, the command button returns to its original display.

• A command button supports two modes:
  ○ Enabled: Allows the user to choose the button
Disabled: Displays a non-selected action, with no option to perform it

A command button is disabled until an action in the same screen activates it, for example, the Next button in a wizard is disabled until all the actions in the screen are completed.

For more information about command button usage and placement, see Graphic Design Guidelines – Command Buttons.

Visual Specifications

Shape

- The button shape is rectangular. The inside of the rectangle is in the shape of a three-dimensional raised cylinder.
- Button Height: 19 pixels
- Button Width: Depends on the length of its label. For more information, see Graphic Design Guidelines – Command Buttons
- One of the buttons in the window may be defined as the default button. This button is activated by pressing Enter. The default button is surrounded by a 1-pixel black frame:
- When chosen, the button looks selected:

Label

- The button should have a short, meaningful label, preferably one word written in black and centrally aligned
- The underlined letter in the label serves as a mnemonic for this button. Typing $Alt+<mnemonic>$ is equivalent to choosing the button. The mnemonic should be unique within the window.

Note

Not all buttons have mnemonics, for example the main window buttons, such as OK and Cancel do not.

Tooltip

Usually, a command button would not have a tooltip. When it does, it may be one or both of the following:

- Static tooltip (optional) - Full button name: If the button label is very long (potentially after translation), the button label is truncated and appended with an ellipsis. The full button label is dynamically added as a tooltip.
- Description (optional): A button may have, in addition to the label, a Description attribute: If the button operation is very complex and is not obvious in a short label, the planner can create a shorter label and add a description of the button’s function.

When a button’s tooltip contains both the full name and a description, the tooltip spans two lines.

GUI Attributes

Consider the following attributes when creating a command button:

- Label
• Mnemonic
• Is it a default button: yes/no
• Tooltip text (optional)
• Tooltip Description text (optional)
• System Information

**Functional Specifications**

**Operation Procedure**

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The button's label/description is displayed in the status bar.</td>
</tr>
<tr>
<td>Choose the button</td>
<td>While the mouse is pressed, the button looks selected. It then reverts to its usual state. The designated action is performed.</td>
</tr>
</tbody>
</table>

**Keyboard Shortcuts**

- Alt + <underlined letter> activates the appropriate button
- Enter activates the default button, if one is present

**4.4.2 List Box Button**

Usage Example: **Administration → Choose Company**.

**When to use?**

To perform one action from a list of defined actions.

**General Description**

- The list box button is a rectangular control with a label that represents the action the button triggers
- The right side of the button is an arrow button which opens a list box when clicked
- The list box contains a list of actions from which to choose
- The user selection becomes the default name of the button from that point on
- To perform an immediate action, the user chooses the button
- When the user presses the mouse button, the input focus moves to the command button and the button display changes to its selected appearance. If the user moves the mouse pointer off the command button while the mouse button is pressed, the command button returns to its original display.
- A List box button supports two modes:
  - Enabled: Allows the user to choose the button or the list box arrow
  - Disabled: Displays a non-selected action, with no option to perform it
• If an action needs to take place, other command buttons (such as the Next button) should be disabled until the action is performed.

For more information about command button usage and placement, see Graphic Design Guidelines – Command Buttons.

Visual Specifications

Shape

• The button shape is rectangular. The inside of the rectangle is in the shape of a three-dimensional raised cylinder:

• The button comprises two parts. Left side: a regular button with text. Attached on the right side: A button with a list box icon

• Button Height: 19 pixels

• Button Width: Depends on the length of its label. For information about button widths, see Graphic Design Guidelines – Command Buttons

• When a list box button is defined as the default button, you can activate it by pressing Enter. The default button is surrounded by a 1-pixel black frame

• When chosen, the button looks selected

Label

• The button should have a short, meaningful label, preferably written in black and centrally aligned

• One of the letters in the label might be underlined. This letter is used as a mnemonic for the button. Typing Alt+<mnemonic> is equivalent to choosing the button. The mnemonic should be unique within the window.

Tooltip

Usually, a list box button would not have a tooltip (see Tooltip).

When it does, it may be one or both of the following:

• Static Tooltip (optional) - Full button name: If the button label is very long (potentially after translation), the button label is truncated and appended with an ellipsis. The full button label is dynamically added as tooltip.

• Description (optional): A button may have, in addition to the label, a Description attribute: If the button operation is very complex and not obvious in a short label, the planner can create a shorter label and add a description of the button’s function.

When a button’s tooltip contains both the full name and a description, the tooltip spans two lines.

GUI Attributes

Consider the following attributes when creating a list box button:

• Label

• List of values

• Mnemonic
• Is it a default button (yes/no)
• Tooltip text (optional)
• Tooltip description text (optional)
• System information

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The button’s label/description is displayed in the status bar.</td>
</tr>
<tr>
<td>Choose the button</td>
<td>While the mouse is pressed, the button looks selected. It then reverts to its usual state. The designated action is performed.</td>
</tr>
<tr>
<td>Choose the arrow button</td>
<td>The button changes its look to ‘selected’. While the mouse is pressed, a list of actions is opened. The default action is signed in yellow.</td>
</tr>
<tr>
<td>Click the action when the list is displayed</td>
<td>The selected action is highlighted in yellow and updates the button.</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts

• Alt + <underlined letter> activates the appropriate button
• Enter activates the default button, if one is present

4.4.3 Back Arrow Icon

Usage Example: Reports → Inventory → Items List.
When to use?

The back arrow lets you return from a subordinate window to the parent window. For example, a selection criteria window is the parent window in which the user defines the filters that create a specific report. The results window contains the back arrow that lets you return to the selection criteria window and redefine the filters.

General Description

A button located on a subordinate window is used to navigate back to the primary parent window.

Usage Example: Inventory → Inventory Reports → Items List.

Visual Specifications

- Use this icon:
- Icon Size: 22x20 pixels
- Locate the icon on the lower-left corner of the subordinate window:
The Back Arrow icon is accompanied by an OK button, which closes the report and the selection criteria window, and saves any changes to the report.

On editable forms, the Back Arrow icon and the OK button could be accompanied by a Cancel button. The Cancel button removes any changes in the results window, closes the window and puts the selection criteria window in focus.

The following tooltips are attached to the button: ‘Back to Selection Criteria’ (see Tooltip).

GUI Attributes

Consider the following attributes when creating the Back Arrow icon:

- Tooltip text
- System information

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>A tooltip is displayed: ‘Back to Selection Criteria’</td>
</tr>
<tr>
<td>Click the Back Arrow icon</td>
<td>The back arrow moves down, closes the window, and puts the parent selection criteria window in focus.</td>
</tr>
<tr>
<td>Choose the OK button</td>
<td>Closes both the report and the selection criteria window. Any changes made to the report are saved.</td>
</tr>
<tr>
<td>Choose the Cancel button</td>
<td>Closes the window and puts the parent selection criteria window in focus. Any changes made to the form are discarded.</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts

None

4.4.4 Graph Icon

Usage Example: Business Partners → Business Partner Master Data.

When to use?

Displays detailed field, field group or window-related data in a graph format.
General Description

- A graph icon related to a specific field (or field group) is placed next to that field.
- A graph icon related to the whole window is located in the lower-right corner of the window.
- Clicking the graph icon opens a separate window containing additional information and a graph related to the specific field or to the whole window.
Visual Specifications

- Use this icon:
- Icon size: 12x12 pixels
- Icon position:
  - To the right of the field or field group to which the graph relates:
  - In the bottom-right corner of the window to which the graph relates, 8 pixels from the window’s edges:

![Graph Icon Example]

- A tooltip is attached to the icon (see Tooltip). The tooltip should say:
  - Row 1 – Static Tooltip: Show Graph
  - Row 2 – Target Tooltip: Name of Graph (Dynamic Name)

GUI Attributes

- Static Tooltip text
- Target Tooltip text
- System Information

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>A tooltip is displayed</td>
</tr>
<tr>
<td>Click the icon</td>
<td>When the mouse button is pressed, the graph color changes to and a graph window is displayed.</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts
None

4.4.5 Insert Image and Clear Image Icons

Usage Example: Human Resources → Employee Master Data window.

When to use?
Browse for an image that you want to load into a window.

General Description
• The Insert Image icon opens an Open window used to find and load an image into a designated area in a form
• The images to be loaded must be placed under a predefined folder (defined by the picture folder in General Settings → Path tab)
• A selected image is loaded and displayed in the designated area
• A Clear Image icon enables the user to delete the image.

Visual Specifications
• To load an image: (Insert Image)
• To remove a loaded image: (Clear Image). This icon does not appear until an image is loaded
• Icon size: 16x16 pixels
• Icon position:

  Image Display Area

  10 px

  5 px

• A tooltip is attached to each icon (see Tooltip). The tooltip of the Insert Image icon should say Insert Image. The tooltip of the Clear Image icon should say Clear Image.
GUI Attributes

- Tooltip text
- System information

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>A tooltip is displayed</td>
</tr>
<tr>
<td>Click <em>Insert Image</em> icon</td>
<td>An <em>Open</em> window is displayed, located in the folder defined for pictures in <em>General Settings</em> → <em>Path</em> tab. If no picture folder was defined, an error message is issued.</td>
</tr>
<tr>
<td>Image selected in the <em>Open</em> window</td>
<td>The image is displayed in the designated area. A <em>Clear Image</em> icon is displayed above the <em>Insert Image</em> icon.</td>
</tr>
<tr>
<td>Click <em>Clear Image</em> icon</td>
<td>Image is removed from the window</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts

None

4.4.6 Link Arrow Icon

Usage Example: *Sales – A/R* → *Sales Quotation*.

When to use?

Drill down for more information.

General Description

- The link arrow icon accompanies a field containing an object reference
- The field can be a text field, a list box, a cell within a table, and so on
- The link opens a subordinate window containing additional information relevant to the text in the corresponding field
- Example: in the *Business Partner Master Data* window, clicking the link arrow icon attached to the *Deliveries* field opens the *Delivery Balance* window.
Visual Specifications

- Use this icon: ![Icon](image.png)
- Icon size: 12x9 pixels
- When the link arrow icon is attached to a field:
  ![Field Example](image.png)
  - A tooltip is attached to the link arrow icon (see Tooltip). The tooltip should say:
    - Row 1 – Static Tooltip: “Link to”
    - Row 2 – Target Tooltip: Name of Object to be displayed (Dynamic Name)
  - Example:
    ![Table Example](image.png)
    - When the link arrow icon is attached to a cell in a table:
      ![Table Example](image.png)
      - When the link arrow icon is pressed, its shape changes to selected arrow:

GUI Attributes

- Static Tooltip text
- Target Tooltip text
- System information

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>A tooltip is displayed</td>
</tr>
<tr>
<td>Click the link arrow icon</td>
<td>While mouse button is pressed, the link arrow icon shape looks selected:</td>
</tr>
<tr>
<td></td>
<td>An additional window is displayed, showing more information about the object referenced in the field.</td>
</tr>
</tbody>
</table>
### 4.5 Complex Data Controls

#### 4.5.1 Table

<table>
<thead>
<tr>
<th>#</th>
<th>Item No.</th>
<th>Item Description</th>
<th>Quantity</th>
<th>Unit Price</th>
<th>Tax Code</th>
<th>Total (LC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10434</td>
<td>132 V-75 Black</td>
<td>5</td>
<td>$ 16.00</td>
<td>MI</td>
<td>$ 50.00</td>
</tr>
<tr>
<td>2</td>
<td>10810</td>
<td>258 B-70</td>
<td>5</td>
<td>$ 16.00</td>
<td>MI</td>
<td>$ 50.00</td>
</tr>
<tr>
<td>3</td>
<td>11625A</td>
<td>RV-111E-161 Input Gear</td>
<td>1</td>
<td>$ 7.00</td>
<td>MI</td>
<td>$ 7.00</td>
</tr>
<tr>
<td>4</td>
<td>1274128</td>
<td>RH-6E Motor Flange</td>
<td>1</td>
<td>$ 5.00</td>
<td></td>
<td>$ 5.00</td>
</tr>
<tr>
<td>5</td>
<td>12 x 8 x 63 KEY</td>
<td>RV-900C-268.3 KEY 12x8x63</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**When to use?**

- To simultaneously display a limited number of records
- To display details of records, or to select one of them for further investigation or operation
- When item details are to be displayed
- To display a large amount of data in an organized manner in a relatively small space

**General Description**

- Tables are used to enter large amounts of data
- A table has a layout similar to a spreadsheet, such as Excel
- A table is made of columns and rows. All cells in a column contain data of the same type, and each row is a data structure of the same type. For example, a row may represent a warehouse stock item, and the columns represent information fields about the items.

<table>
<thead>
<tr>
<th>#</th>
<th>Item No.</th>
<th>Item Description</th>
<th>Quantity</th>
<th>Unit Price</th>
<th>Tax Code</th>
<th>Total (LC)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>10434</td>
<td>132 V-75 Black</td>
<td>5</td>
<td>$ 10.00</td>
<td>MI</td>
<td>$ 50.00</td>
</tr>
<tr>
<td>2</td>
<td>10810</td>
<td>258 B-70</td>
<td>5</td>
<td>$ 10.00</td>
<td>MI</td>
<td>$ 50.00</td>
</tr>
<tr>
<td>3</td>
<td>11625A</td>
<td>RV-111E-161 Input Gear</td>
<td>1</td>
<td>$ 7.00</td>
<td>MI</td>
<td>$ 7.00</td>
</tr>
<tr>
<td>4</td>
<td>1274128</td>
<td>RH-6E Motor Flange</td>
<td>1</td>
<td>$ 5.00</td>
<td></td>
<td>$ 5.00</td>
</tr>
<tr>
<td>5</td>
<td>12 x 8 x 63 KEY</td>
<td>RV-900C-268.3 KEY 12x8x63</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Each table has the following elements:
  - The Header – contains the table name
  - The column headers – define the content of each column; used for sorting as well
  - A selection button column – selects a whole row. The selection column, if it exists, is always the first one to the left. This column can also be used as a row numbering column. Row numbers usually correspond to one of the following:
    - IDs in the database
    - Sequential row numbers in the table (1 – N)
  - The actual "table" or data area
Scroll bars – vertical or horizontal (if necessary)

**Note**

It is highly recommend that the initial width of the table be such that all columns are visible without a horizontal scroll bar. Therefore, you may ignore the requirement to leave an extra 30% for each column title.

**Sorting**

A table can be sorted by one of its columns.

- An arrow sign (▲ or ▼) appears on the corner of the sorting column, to indicate an ascending or descending sort order.
- The user can sort the table by double-clicking any of the column headers.

When the table is initially displayed, it should have a default sorting order. Row numbers are necessary for any table where the sort order can be changed. If users sort by Name, or some other column, then they can restore the original sort order by sorting a row number.

**Table Cells**

- Cells in a table may be editable or read-only
- Rows can be added, deleted or duplicated. The commands to perform these actions are located in the Data and the context menus
- Typically, table cells contain numeric or alphanumeric text. Other available cell types include:
  - Text: Text cell in an input table - the text can be edited. In an output table or lists the text is in a read-only mode and the user can only sort or filter it
  - Image: Displays an icon or image
  - Link: Contains a link
  - Button: Contains a button
  - Input: Can be edited
  - Dropdown list box: Contains a drop-down list box
  - Checkbox: Cell contains a checkbox
- A table can be associated with the Row Details window, which contains detailed information on a row in a table and allows editing of row fields in a form
- The user can customize the structure of each table using the Form Settings function associated with the window that contains the table
- There are several menu commands related to table handling:
  - The Data menu contains row manipulation commands
  - The Data → Advanced submenu contains commands for specific windows (not all windows have commands in this submenu)
  - The Goto menu contains the Row Details command.

**Cursor Position**

The cursor position always reflects the place that the user activated.
Context Menu

You can perform specific actions on a cell by right-clicking the cell. All row actions appear in the cell context menu (right-click), but not vice versa.

Resizing a Table

- Tables may contain large amounts of information, and the user may want to resize the table to see more information.
- When you build a window that contains a table, make sure the window is resizable and contains a maximize button on its title bar.

Scroll Bars

- A scroll bar is used to scroll the contents of a table.
- A vertical scroll bar is always attached to the right side of a table. If the table does not require scrolling, the scroll bar is not active, and the scroll thumb (the rectangle inside the scroll bar) is not shown.
- A horizontal scroll bar appears only in tables that are too wide. Note that horizontal scroll bars reduce the usability of a table, and should be avoided.

Visual Specifications

| Note |

Indicator and Picker images appear according to user customization settings in the View menu.

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Column</td>
<td>Each column header is shaped like a button. The header label is left aligned.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the column is too narrow to fit the column title, the title is truncated and appended with an ellipsis.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A tooltip should show the full column name.</td>
<td></td>
</tr>
<tr>
<td># Item No.</td>
<td>Item Description</td>
<td></td>
</tr>
<tr>
<td># Item Descri...</td>
<td>Quantity</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Specification</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Row header (optional)</td>
<td>The row header looks like a gray rectangular button and contains a row number, left aligned.</td>
<td><img src="image" alt="Row Header Example" /></td>
</tr>
<tr>
<td>Grid Lines</td>
<td>Horizontal and vertical lines: 1-pixel #C6C6BD</td>
<td><img src="image" alt="Grid Lines Example" /></td>
</tr>
<tr>
<td>Row header - selected</td>
<td>The row header looks pushed in. The selected row’s background color changes to dark yellow (#FCDD82)</td>
<td><img src="image" alt="Row Header Selected Example" /></td>
</tr>
<tr>
<td>Empty space on the side of the table</td>
<td>If the table columns do not cover the full width of the table, an empty space remains on the right side. This space is colored in #D9E5F2. To prevent empty margins, we recommend that the default column width fill the whole table area.</td>
<td><img src="image" alt="Empty Space Example" /></td>
</tr>
<tr>
<td><strong>Cells</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Table Field (general)         | Height: 15 pixels  
Distance between text and border: 2 pixels  
Separation line (#C6C6BD)  
Separation line (width: 1 pixel )                                                                                             | ![Table Field Example](image)                |
<p>| Text in tables                | The text in tables is black. Use colors sparingly and only for emphasis of special cases. Choose colors that are well distinguished and are readable.                                                             |                                              |
| Tooltip                       | If the cell is smaller than the text it contains, a tooltip is dynamically added to the cell, showing the full text of the cell.                                                                                | <img src="image" alt="Tooltip Example" />                     |
| Read-only field in the table  | Background: #D9E5F2                                                                                                                                                                                         | <img src="image" alt="Read-only Field Example" />            |
| Read/Write field in the table | Background: white                                                                                                                                                                                             | <img src="image" alt="Read/Write Field Example" />           |
| Read/Write field in focus     | Background: #FCDD82                                                                                                                                                                                          | <img src="image" alt="Read/Write Field in Focus Example" />  |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dropdown menu in a table</td>
<td>Icon location: 2 pixels from the right edge of the cell.</td>
<td><img src="image" alt="Dropdown Example" /></td>
</tr>
<tr>
<td>Link to object</td>
<td>Icon location (inside field): 1 pixel from left edge, 4 pixels from text</td>
<td><img src="image" alt="Link Example" /></td>
</tr>
<tr>
<td>Checkbox in a table</td>
<td>Location: centered</td>
<td><img src="image" alt="Checkbox Example" /></td>
</tr>
<tr>
<td><strong>Sorting</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sorting indicator - down</td>
<td>Image at the top right corner of the column header button; appears when column is sorted.</td>
<td><img src="image" alt="Sorting Down Example" /></td>
</tr>
<tr>
<td>Sorting indicator - up</td>
<td>Image at the top right corner of the column header button; appears when column is sorted.</td>
<td><img src="image" alt="Sorting Up Example" /></td>
</tr>
<tr>
<td><strong>Filtering</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filter Indicator on</td>
<td>Image at the top right corner of the column header button; appears when column is filtered.</td>
<td><img src="image" alt="Filter Example" /></td>
</tr>
<tr>
<td><strong>Indicators</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List of values indicator</td>
<td>Image at the top right corner of the column header button.</td>
<td><img src="image" alt="List Indicator Example" /></td>
</tr>
<tr>
<td>User Defined List Indicator</td>
<td>Image at the top right corner of the column header button</td>
<td><img src="image" alt="User Defined List Example" /></td>
</tr>
<tr>
<td>Translator Indicator</td>
<td>Image at the top right corner of the column header button</td>
<td><img src="image" alt="Translator Example" /></td>
</tr>
<tr>
<td><strong>Pickers</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List of values Picker</td>
<td>Image on the right side of the table cell</td>
<td><img src="image" alt="List Picker Example" /></td>
</tr>
<tr>
<td>User Defined List Picker</td>
<td>Image on the right side of the table cell</td>
<td><img src="image" alt="User Defined Picker Example" /></td>
</tr>
<tr>
<td>Translator Picker</td>
<td>Image on the right side of a translatable cell</td>
<td><img src="image" alt="Translator Picker Example" /></td>
</tr>
<tr>
<td>Calculator Picker</td>
<td>Image in the table's numeric cell</td>
<td><img src="image" alt="Calculator Picker Example" /></td>
</tr>
<tr>
<td>Date Picker</td>
<td>Image on the right side of a date cell</td>
<td><img src="image" alt="Date Picker Example" /></td>
</tr>
</tbody>
</table>
### Scroll Bars

**Specification**

A table has a vertical scroll bar on its right side.

If the table is too wide, it has a horizontal scrollbar at the bottom.

**Example**

![Scroll Bars Example](image)

### Tooltip

**Specification**

Appears when the table is scrolled using the scroll thumb and indicates the current row.

Text – Tahoma, 7, black

Background color – light yellow (#FFFFE0)

Frame Color: #666666

**Example**

![Tooltip Example](image)

### Summary Fields

#### Sum field labels

The labels for summary fields appear at the bottom of the table, on the left side of the sum field on the very left side.

The labels resemble button labels and have a 3D look.

#### Sum fields

Each summary field appears at the bottom of the table, under the relevant column.

The fields resemble buttons and have a 3D look.

**Example**

<table>
<thead>
<tr>
<th>GA Account/IDP Name</th>
<th>Debit %</th>
<th>Credit %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash on Hand (HO, USA, GA)</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Cash at Bank - Payroll (HO, US)</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>50</td>
<td></td>
</tr>
<tr>
<td><strong>To Balance</strong></td>
<td>10</td>
<td></td>
</tr>
</tbody>
</table>

### GUI Attributes

A table is usually constructed of the following elements:

- **Header:** Names the table; not necessarily the header of the window
- **Column headers:** Define the content of each column
- **Column Definition:**
  - Label
  - Field type
  - GUI Attributes according to field type
  - Alignment (Left/Right/Center)
  - Default width
Functionality: read, or read + write
Sorting: Yes/No
Tooltip (added dynamically)

Field (Cell) Definition:
Default value (optional)
Tooltip (added dynamically)

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>Action Type</th>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort Operation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sort Table</td>
<td>Double-click table header</td>
<td>Sorts table by the column (if sorting function exists).</td>
</tr>
<tr>
<td>Ascending / Descending Sort</td>
<td>Double-click a table header again</td>
<td>Double-click a table header again Sorts table in ascending / descending order by the column (if sorting function exists).</td>
</tr>
</tbody>
</table>

Resize Columns and Table

Mouse over the table border
Rollover the table header between columns
Mouse cursor changes to the Resize shape: 

Resize column
Click and drag the mouse when the cursor is in the resize position.
Resizes column.
When resizing the last column and making it smaller than the table size, a gray area appears on the right side of the table:

<table>
<thead>
<tr>
<th>Resize column</th>
<th>Double-click the mouse when the cursor is in the resize position.</th>
<th>Auto fits the column width according to the largest text width.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize table</td>
<td>Resize a window containing a table.</td>
<td>When the window is resized, the table and its columns are resized proportionally.</td>
</tr>
</tbody>
</table>

Selection

Cell selection
Click a cell/read-only field
The color of the selected cell changes to light yellow.
Any previous selection is deselected.
<table>
<thead>
<tr>
<th>Action Type</th>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text selection</td>
<td>Click a cell/read/write field</td>
<td>Focus on the field and text selection within a cell.</td>
</tr>
<tr>
<td>Row selection</td>
<td>Click a row number in the left num. (#) column</td>
<td>The button looks selected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The row is selected.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The color of the selected row changes to yellow.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="1408.png" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clicking the same row number again deselects the row.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clicking a different row or a cell of a different row, deselects the previous row.</td>
</tr>
<tr>
<td>Row information</td>
<td>Double-click a row number in the left number (#) column</td>
<td>Opens the Row Details window for viewing/editing the row (optional, currently implemented in marketing documents).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In some cases, the Detailed Information window is opened instead of the Row Details window.</td>
</tr>
</tbody>
</table>
| Multiple row selection | Click the left number (#) column  
+ SHIFT to select a range of rows  
+ CTRL to select separated rows | Menu/Context Menu                                                                                                                              |
| Manipulate cell values | Select Cut/Copy/Paste/Delete from the cell’s context menu            | The cell value is cut, copied, pasted or deleted accordingly.                                                                                 |
| Delete row          | Select Delete Row from the context menu                                       | The selected row is deleted                                                                                                                    |
| Add row             | Select Add Row from the context menu                                         | An empty row is added below the selected row.                                                                                                  |
| Duplicate row       | Select Duplicate Row from the context menu                                  | The selected row is duplicated below itself                                                                                                   |

**Keyboard Shortcuts**

- **Ctrl+I**: Adds a row below the selected row
- **Tab**: Navigates through cells in a table
  
  The cursor jumps to the first column of the selected row.
• Shift + Tab: Navigates backwards through a row
• Ctrl+K: Deletes the row in which the cursor is located
• Ctrl+M: Duplicates the row in which the cursor is located
• Ctrl+L: Displays the Row Details of the selected row
• Ctrl+X: Cuts the selected cell’s value to the clipboard
• Ctrl+C: Copies the selected cell’s value to the clipboard
• Ctrl+V: Pastes the last value added to the clipboard into the selected cell
• DEL: Deletes the selected cell’s value
• UP/DOWN arrows: Moves the cursor to the previous/next row
• Left/Right arrows: Moves the cursor to the previous/next cell.

Sorting and Filtering a Table

Filtering and Sorting are two means by which a user can more efficiently manage a large number of records. Filtering decreases the amount of information displayed in a table, while Sorting rearranges the information in a more useful way.

Two icons are available on the main toolbar when a window containing a table is active:

Filtering

• Clicking the Filter Table icon in the toolbar, or selecting the Filter Table command from the context menu, displays the Filter Table window in which the user selects the filtering criteria.

• When a table is filtered, the Filter Table icon appears in the top-right corner of the filtered column:

<table>
<thead>
<tr>
<th>ID</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>C_1</td>
<td>Copy</td>
</tr>
</tbody>
</table>

• The Filter Table icon size is 8x7 pixels

• After you set filters and close the Filter Table window, the Filter Table icon on the toolbar remains selected:

• When a table is filtered, clicking the chosen Filter Table icon clears the filter in the report (and the icon goes back to the normal state)
• When a table is filtered, choosing the *Filter Table* command from the context menu clears the filter.

• When the *Filter Table* window is re-opened, it remembers the last filtering criteria used for this type of report.

• Limitations:
  o You cannot filter a Hierarchical Table (see *Hierarchical Table*).
  o You cannot filter tables in marketing documents.

**Sorting**

• This option allows you to sort a table by multiple criteria.

• Clicking the *Sort Table* icon on the toolbar or selecting the *Sort Table* command from the context menu, displays the *Sort Table* window, in which the user selects the sorting criteria.

• When a table is sorted, the *Sort Table* icon appears in the top-right corner of the sorted column:

  The sort icon is UP for the ascending sort, or DOWN for the descending sort.

  The icon size is 8x4 pixels.

• Limitations:
  o You cannot sort a Hierarchical Table
  o You cannot sort tables in marketing documents

**Combination of Sorting and Filtering**

• You can filter a table after it has been sorted, and vice versa.

• When a table is filtered and sorted, both marks appear next to the appropriate column titles. If the same field is used for both sorting and filtering, they appear next to the same title.
4.5.2 Hierarchical Table

Usage Example: Reports → Inventory → Inventory Audit Report

When to use?
When the records in a table are part of a hierarchical structure.

General Description

- A hierarchical table contains records nested within their logical parents
- The hierarchy may include two or more levels
- Typically, there is a parent column, followed by a child column:

  ![Table Example]

- The parent cell contains an Expand / Collapse icon to show/hide the rows of descendant records below the parent record
- Two buttons, Expand All and Collapse All, should be placed below the table to expand/collapse all rows at once
- The hierarchy of records in the table is indicated by a color scheme: each row displays a different background color based on its level in the hierarchy. The color scheme uses light blue colors for an editable table and gray colors for a read-only table.
- In mixed tables, where part of the table is editable and part is read-only, each cell is colored accordingly:
Visual Specifications

Visual specifications for Hierarchical Table are similar to Table (see Table), with some additions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hierarchy in read-only tables</td>
<td>Background color of the first level: #D2E1F0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Background color of the second level: #E2ECF8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Background color of inner rows: #EEF4FB</td>
<td></td>
</tr>
<tr>
<td>Hierarchy in editable tables</td>
<td>Background color of the first level: white</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Background color of the second level: #F7F7F7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Background color of inner rows: #EEEEEE</td>
<td></td>
</tr>
<tr>
<td>Expand icon</td>
<td>Indicates a hidden detailed view of related items.</td>
<td></td>
</tr>
<tr>
<td>Collapse icon</td>
<td>Indicates a full view of related items</td>
<td></td>
</tr>
</tbody>
</table>

GUI Attributes

For information, see Table.

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>Action Type</th>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand item</td>
<td>Clicks the Expand icon</td>
<td>Rows of immediate descendants are exposed below the parent row. The icon changes to Collapse.</td>
</tr>
<tr>
<td>Collapse item</td>
<td>Clicks the Collapse icon</td>
<td>Rows of all descendants are hidden. The icon changes to Expand.</td>
</tr>
<tr>
<td>Expand all</td>
<td>User chooses the Expand All button</td>
<td>All rows are exposed</td>
</tr>
<tr>
<td>Collapse all</td>
<td>User chooses the Collapse All button</td>
<td>All rows, except for the top (highest) level are hidden</td>
</tr>
</tbody>
</table>
4.5.3 Row Types

Usage Example: Sales – A/R → Sales Quotation.

**Note**
This control is built from multiple controls.

**When to use?**
To allow different types of rows in a table.

**Note**
The Type column is not displayed in all tables by default. In order to display and activate it in a specific form, click (Form Settings) and set the Type field to Visible and Active.

**General Description**
- The Type column typically appears in item tables of sales documents
- The Type column contains a list box that allows the user to create several row types:
  - Regular row (item)
  - Alternative item: A potential replacement for the regular item preceding it.
  - Text: A row containing free text. Free text may be used to describe the content of the rows following it. Editing a text type row is performed in a separate window.
  - Subtotal: A subtotal row sums up all the regular rows preceding it. A second level subtotal row sums up all the preceding first-level subtotals, and so on. Each level of a subtotal has a different color.

**Visual Specifications**
Visual specifications for Hierarchical Table are similar to Table (see Table), with some additions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type field</td>
<td>Contains a drop-down menu with options for the row type.</td>
<td>![Image]</td>
</tr>
<tr>
<td>Regular row</td>
<td>The Type field is empty</td>
<td>![Image]</td>
</tr>
</tbody>
</table>
### Item  
**Specification**  
**Example**

#### Alternative item row
The **A** symbol appears in the *Type* field.

<table>
<thead>
<tr>
<th>#</th>
<th>Type</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>T</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>A</td>
<td></td>
</tr>
</tbody>
</table>

#### Text row
The **T** symbol appears in the *Type* field.

All cells in the row are merged and contain free text.

Text rows must be edited using the text editor as they are not editable directly in the table.

<table>
<thead>
<tr>
<th>#</th>
<th>Type</th>
<th>Item No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>T</td>
<td>sales</td>
</tr>
<tr>
<td>2</td>
<td>T</td>
<td>purchase</td>
</tr>
<tr>
<td>3</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>A</td>
<td>0_3</td>
</tr>
</tbody>
</table>

#### Subtotal row
The **Σ** symbol appears in the *Type* field. After a row is added, the color of that row changes in relation to the status of the other rows.

The last row added has the darkest row and is filled with the same color used for read only fields.

Background – light blue (#D9E5F2)

Text – black

Black line above the row gives the row a “selected” look

<table>
<thead>
<tr>
<th>#</th>
<th>Type</th>
<th>Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>A</td>
<td>0_3</td>
</tr>
<tr>
<td>5</td>
<td>Σ</td>
<td></td>
</tr>
</tbody>
</table>

### GUI Attributes
For information, see [Table](#).

### Functional Specifications

#### Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select <em>Text</em></td>
<td>A window is displayed that allows the user to enter free text. All cells in the row (except for the <em>Type</em> cell) are merged into one cell, showing the text row.</td>
</tr>
<tr>
<td>Select <em>Alternative</em></td>
<td>The row changes to an alternative item. An alternative item is not calculated in the subtotals and totals.</td>
</tr>
</tbody>
</table>
### User Interface Standard and Guidelines

#### 4.5.4 Tree Control

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Subtotal</td>
<td>The row color changes to the appropriate color; subtotal is calculated in all relevant cells.</td>
</tr>
</tbody>
</table>

**Usage Example:** Business Partners → Business Partner Master Data → Payment System → Choose Bank field

**When to use?**
- When the data objects are arranged in a hierarchical structure
- When the user needs to access these data items according to their hierarchy.

**General Description**
- A Tree control supports the representation of hierarchical data items, displayed in a "tree" structure
- The (Expand) and (Collapse) controls display or hide nested levels of the tree
- The lower level of the tree contains "leaf" nodes, which users select to display data

**Visual Specifications**
- Each level is indented 15 pixels to the right, relative to its parent
- Each root node and intermediate node is comprised of the node name and an expand/collapse icon, which is located 5 pixels to the left of the node name. The button supports two modes:
  - Expand: Click to display the next level of the tree, that is, the immediate children of the node
  - Collapse: Click to hide all the sub-tree nested under the node
- Triangle size: 9 x 6 pixels
- Text color: black by default. You may add other colors to highlight special nodes, as in the example above. Add colors only if they help the user understand the data in the tree. Limit the number of colors to a maximum of two or three.
- Node height: 16 pixels. The node name and icon are centered in this 16-pixel strip
- The strip of a highlighted leaf node is dark yellow (#FCDD82)

GUI Attributes

Consider the following when creating a tree control:

For each node:
- Node type: Root, Intermediate, Leaf
- Node name
- Subnodes
- Description text
- Tooltip (added dynamically)
- System information

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The node’s description text is displayed in the status bar</td>
</tr>
<tr>
<td>Click (Expand)</td>
<td>While the mouse is pressed, the icon changes its shape to the selected look.</td>
</tr>
<tr>
<td></td>
<td>Any nodes nested under the clicked node are displayed. The icon changes to</td>
</tr>
<tr>
<td></td>
<td>Collapse mode.</td>
</tr>
<tr>
<td>Click (Collapse)</td>
<td>While the mouse is down, the icon changes its shape to the selected look.</td>
</tr>
<tr>
<td></td>
<td>The icon changes to Expand mode. Any nodes nested under the node (all the way</td>
</tr>
<tr>
<td></td>
<td>down to the leaves) are hidden.</td>
</tr>
<tr>
<td>Click a non-leaf node</td>
<td>Optionally, selects the node and the node is highlighted</td>
</tr>
<tr>
<td>Click a leaf node</td>
<td>The node is highlighted</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts

None

4.5.5 Tree-Table Control

<table>
<thead>
<tr>
<th>Item No.</th>
<th>Item Description</th>
<th>In Stock</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>01</td>
<td>0.000</td>
</tr>
<tr>
<td>3</td>
<td>A_1</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>A_1</td>
<td>0.000</td>
</tr>
<tr>
<td>5</td>
<td>A_2</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>A_1</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>B_1</td>
<td></td>
</tr>
</tbody>
</table>
Usage Example: *List of Items* window (click  (Form Settings) and select *Grouping by Item No.*).

**When to use?**
- When the data records in a table are grouped by one (or more) of the fields, thus creating a hierarchical structure
- Typical usages:
  - In *List of <objects>* windows, when the user selects to arrange the objects by groups
  - In *Report* windows, when it adds value to display data records by hierarchical groups

**General Description**
- The tree-table control is based on a table
- The records displayed in the table are grouped by one of the fields (columns). Each value in this field becomes a node in the tree. The leaf nodes are all the data records that share this field value, and these data records are displayed as regular table rows.
- The tree uses the standard mechanism of an Expand/Collapse (Plus/Minus) button next to the grouping value, used to display/hide the branch
- A tree-table may be grouped by several values, thus creating a multi-level tree:

<table>
<thead>
<tr>
<th>#</th>
<th>Item No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>01</td>
</tr>
<tr>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>01</td>
</tr>
<tr>
<td>4</td>
<td>A1</td>
</tr>
</tbody>
</table>

- The tree-table is always sorted by the grouping fields. In addition, the user can sort the leaf records by double-clicking the column headers
- It is currently not possible to use advanced sort and filters in a tree-table

**Visual Specifications**
- The tree nodes are displayed inside the first column of the table. The nodes share the column with the first field of the leaf record. The title of the column is that of the first field. (In the figure
above, the column title is *Item Description* which is the first field in the leaf record). The grouping fields do not get a title in the table.

- Each level is indented 9 pixels to the right, relative to its parent
- Each root node and intermediate node is comprised of the node name and an *Expand/Collapse* icon located 5 pixels to the left of the node name. The icon supports two modes:
  - Expand (Plus): Click to display the next level of the tree, that is, the immediate children of the node
  - Collapse (Minus): Click to hide all the sub-tree nested under the node
- Button size: 9 x 9 pixels
- A dotted black line connects the tree nodes
- The strip of a highlighted leaf node is dark yellow (#FCDD82)
- Two buttons *Expand All* and *Collapse All* should be placed below the tree-table to expand/collapse all nodes

**GUI Attributes**

For each node, consider the following:

- Node type: Root, Intermediate, Leaf
- Node name
- Node information (data displayed in columns)
- Subnodes
- Description text
- System information

**Functional Specifications**

**Operation Procedure**

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The node’s description text is displayed in the status bar</td>
</tr>
<tr>
<td>Click [+] (Expand)</td>
<td>All nested nodes are displayed. The icon changes to [ ] (Collapse)</td>
</tr>
<tr>
<td>Click [ ] (Collapse)</td>
<td>All nested nodes (all the way down to the leaves) are hidden. The icon changes to [+ (Expand)]</td>
</tr>
<tr>
<td>Click a leaf record</td>
<td>The row is highlighted</td>
</tr>
</tbody>
</table>

**Keyboard Shortcuts**

None
4.6 Advanced Selection Controls

4.6.1 Account Selector

Usage Example: Financials → Financial Reports → Accounting → Document Journal

When to use?
This control is used in selection criteria windows, where the user selects accounts or a group of accounts for a report.

General Description
- The Account Selector is built from multiple controls
- It is usually located in the upper-right corner of the window
- The control is built as a table containing all the accounts in hierarchical groups. To select an account or group of accounts, the user clicks the x column; the sign “x” is displayed near the selection.

Visual Specifications
- The control is built as a table containing hierarchical groups of accounts
- Table columns:
  - # - row number
  - x – selection column (“x” in this column means the account/group is selected)
  - Account – Account/Group name + link arrow icon
- Text color: red – Level 1, blue – level 2 and 3, black - level 4 and on
- Column height: 10 pixels (less than regular tables)
- The table is serviced by 3 controls:
  - Levels list box above the table (top-right): Originally, when the control is displayed, only one level is displayed:
Find button: Opens a Find window
Accounts checkbox: Displays the table and enables account selection.

GUI Attributes
For each account, consider the following:
- Account Name
- Account Number
- Account Level
- Default selection: Yes / No
- Description Text
- Tooltip (added dynamically)
- System Information

Functional Specifications

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>Displays account’s description text in the status bar</td>
</tr>
<tr>
<td>Select a value from the Levels list box</td>
<td>The corresponding levels are displayed in the tables. All levels lower than the selected one are not displayed. Note that the Account Serial Number (# column) reflects the actual number of the account; therefore, if some levels are not displayed, the serial numbers will not be successive.</td>
</tr>
<tr>
<td>Deselect the Accounts checkbox.</td>
<td>The Accounts table is hidden</td>
</tr>
<tr>
<td>Click a cell in the “x” column</td>
<td>If you click in an account row, this account is selected (“x” is displayed in the cell). If you click in a group row, this group and all accounts below it are selected (marked by an “x”)</td>
</tr>
<tr>
<td>Click the “x” column header</td>
<td>All accounts are selected / deselected (all “x” signs appear/are removed)</td>
</tr>
</tbody>
</table>
4.6.2 Business Partner and Item Selectors

Usage Examples:

- Financials → Financial Reports → Accounting → G/L Accounts and Business Partners
- Inventory → Inventory Reports → Inventory Posting List by Item.

**Note**
This control is built from multiple controls.

**When to use?**
This control is used in selection criteria windows, where the user selects business partners or items for a report.

**General Description**
The Business Partner and the Item selectors are a collection of controls (fields, list boxes, and so on).
The combination of controls may change, depending on the needs of the specific report.

**Visual Specifications**

- The control is usually the main selector in a report; therefore, it is located at the upper-left corner of the selection criteria window
- The control is built from the following fields:
  - Business Partners / Item code range - From/To fields
- Customer Group (optional) / Group – List box containing customer groups / item groups. The default is ‘All’. Ignore this field if you want to select only vendors.

- Vendor Group (optional) – List box containing vendor groups. The default is ‘All’. Ignore this field if you want to select only customers.

- Properties – Property selection control, showing properties of a business partner / item.

Additional selection fields may be added, if required, for example, the Handled by and Contact Person fields:

<table>
<thead>
<tr>
<th>BP Code</th>
<th>From</th>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Group</td>
<td>All</td>
<td></td>
</tr>
<tr>
<td>Vendor Group</td>
<td>All</td>
<td></td>
</tr>
<tr>
<td>Contact Person</td>
<td>All</td>
<td></td>
</tr>
</tbody>
</table>

Properties Selection Field

Properties

Usage Example: Reports → Sales and Purchasing → Sales Analysis

Note

This control is built from multiple controls.

When to use?

- In selection criteria windows, to select items or business partners based on their properties
- The query selects objects that have the properties defined by this control.

General Description

- This control is composed of the Properties button, which displays a window when you click it.
- It lets you select multiple object properties, using checkboxes, and define an AND or an OR relationship between the options.
- The field does not support data entry; it merely reflects the selected properties.

The text field contains one of the following:

<table>
<thead>
<tr>
<th>When</th>
<th>Text Field Shows</th>
</tr>
</thead>
<tbody>
<tr>
<td>No properties are selected, or Ignore Properties is checked in the properties window</td>
<td>Ignore</td>
</tr>
</tbody>
</table>
| All properties are selected               | All Properties [<relation>]

For example:

All properties [OR]
<table>
<thead>
<tr>
<th>When</th>
<th>Text Field Shows</th>
</tr>
</thead>
</table>
| Options are selected (Closed Properties Range checkbox is deselected)| The text is: <n> Properties ]<relation>[
For example: 4 Properties ]AND[ |
| Options are selected (Closed Properties Range checkbox is selected) | The text is: <n> Properties [<relation>] 
For example: 4 Properties [AND] |

**Visual Specifications**

- The Properties button has the usual specifications of a button (see [Button](#)).
- The field has the usual specifications of a text field, when disabled (see [Text Field](#)).
- The Properties button is attached to the left corner of the text field.

**GUI Attributes**

- Default value (optional)
- Description text
- System information

**Functional Specifications**

**Operation Procedure**

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The status bar displays description text.</td>
</tr>
<tr>
<td>Choose the Properties button</td>
<td>The Properties Selection window appears. For information, see Properties Selection Window. The window is displayed as modal. When the window is closed, the text field is updated to reflect the selections made in the window. For information, see Properties Selection Field.</td>
</tr>
<tr>
<td>Click the field</td>
<td>No response (the field is disabled)</td>
</tr>
</tbody>
</table>

**Keyboard Shortcuts**

None
Properties Selection Window

Purpose
This window goes with the Properties field. It enables the user to select a group of object properties to be used as selection criteria in a query.

When to use?
In queries based on the existence of object properties

Screen Layout

Title Bar
This is a standard window title bar. The caption is: Properties.

Options
In the options area, the user selects how the properties affect the query:

- **Ignore Properties** checkbox: If this checkbox is selected, the query does not consider the object properties at all.
- **Closed Properties Range**: This checkbox is shown only when Ignore Properties is deactivated. If this checkbox is selected, the query ignores objects that have any property that is not selected in this window.
- **Link radio buttons**: Offer a choice of an AND or an OR relationship between the selected properties.

Visual Specifications
- The Ignore Properties checkbox appears in the top-left corner of the window.
• The Closed Properties Range is just below it.
• The link radio buttons are in the top-right corner of the window.

Operational Procedures
Selecting the Ignore Properties checkbox makes the rest of the window irrelevant. It also hides the Closed Properties Range checkbox.

Item Properties Table
Displays a list of all properties of the queried object, enabling the user to select the required properties.

Visual Specifications
This is a standard table (see Table).
The table contains 3 columns:
• # : property number
• Property: Name of the property
• Selection: Contains a checkbox next to each property

Operational Procedures
The user selects the checkboxes of the required properties.

Action Buttons
The window contains 4 buttons:
• OK: Closes the window and approves the selected properties. The selection is marked in the Properties field.
• Cancel: Closes the window without checking the properties selection
• Clear Selection: Deselects all the checkboxes in the Items table
• Choose All: Selects all the checkboxes in the Items table

Visual Specifications
• For visual specifications of each button, see Button.
• For specifications on button positioning, see Command Buttons.

Operational Procedure
• Choosing each button performs the operation described in the Purpose section, above.
• Pressing Enter performs the default action, OK.
4.6.3 Date Range Selector

General Description

The control allows the user to select a month, several months, or a whole year. The date range selection options are changed according to a specific business case.

Two typical date range selectors:

- One that allows selection of any month range within a year. The control is a supplement of two test fields specifying the *From*/*To* dates.
- One that selects one month and defines the range from the beginning of the year until the selected month. The control is a supplement of the *To* field.

4.6.4 Extended Checkbox

Usage Example: *Reports → Sales Opportunities → Stage Analysis*

![Note](https://example.com)

This control is built from multiple controls.

When to use?

- When you have a set of related options that should be grouped under one major topic
- When these options are too minor to place in the main window
- A common use of this control is in the selection criteria windows

General Description

- The control consists of a master checkbox and a button labeled: ...
- The master checkbox represents a topic, and has a set of options related to it
- When the master checkbox is selected, the system automatically displays the *Options* window containing multiple selection options
- If any of these options is selected, the master checkbox remains selected
- If no option is selected in the *Options* window, the master checkbox is deselected.

![Note](https://example.com)

This behavior is not implemented in the *Usage Example* above.

- When the user deselects the master checkbox, the system remembers the last settings in the *Options* window and uses them as a default the next time the window is opened.

Visual Specifications

- The master checkbox has the usual specifications of a checkbox
• The … button has the usual specifications of a Button
• The … button is located to the right of the master checkbox label.

GUI Attributes
Same as checkbox and button (see Checkbox, Button).
Checkbox attributes:
• Label
• Mnemonic
• Functionality: read or read + write
• Default value (optional)
• Description text
• System information

Button Attributes:
• Label
• Mnemonic
• Is it a default button (yes/no)
• Tooltip text (optional)
• Tooltip description text (optional)
• System information

Functional Specifications
Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>Displays account’s description text in the status bar</td>
</tr>
<tr>
<td>User Action</td>
<td>System Response</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Choose the ‘...’ button</td>
<td>A window is displayed, in which the user can select several options related to the master checkbox.</td>
</tr>
<tr>
<td></td>
<td>A typical usage of this control is to group a set of checkboxes in this window:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Sales Stage" /></td>
</tr>
<tr>
<td></td>
<td>When the window is closed and an option is chosen, the master checkbox is selected. If no option was selected in the window, the master checkbox is deselected.</td>
</tr>
<tr>
<td>Select the master checkbox while it is deselected</td>
<td>The master checkbox is selected. It opens the same window.</td>
</tr>
<tr>
<td>Deselect the master checkbox while it is selected</td>
<td>The master checkbox is deselected. The options in the options window remain checked, and are used as a default the next time the window is opened.</td>
</tr>
<tr>
<td>Close the Options window without any selection</td>
<td>The master checkbox is deselected</td>
</tr>
<tr>
<td>Close the Options window with at least one selection</td>
<td>The master checkbox is selected</td>
</tr>
</tbody>
</table>

**Keyboard Shortcuts**

None
4.7 View Controls

4.7.1 Tab Strip

When to use?

- When the window cannot accommodate all required information
- When information can be logically divided into several views
- When the views can be accessed in random order (if a specific order is required, use a wizard)
- Do not use tabs to select between mutually exclusive alternatives. If selecting one view disables other views, use a different control to select the view, such as a list box.

General Description

- A tab strip control resembles an index card. It consists of two or more tab elements (tabs)
- Tabs appear as subordinate windows
- One tab is always active and its information is displayed in the page below the tab strip
- Users navigate between the tabs by choosing a tab
- Each tab has a unique label. It is essential that this label be short, preferably one word, and meaningful
- Each tab label has a mnemonic, which is a unique letter used as a shortcut to navigate to this tab. The shortcut letter is underlined. For example, letter ‘N’ in General is used as a shortcut to the General tab. Typing Alt+<mnemonic> is equal to choosing the tab.

Visual Specifications

- Active tab:

- Inactive tab:

- The tab has a 1-pixel white border

Note

This border is NOT created automatically for a tab strip control. When adding this border manually, make sure the border is accurately aligned to the edge of the tab and the tab strip.
• Tab strip height: 19 pixels
• The label is centered on the tab
• The mnemonic in the label is underlined
• The tabs do not all need to be the same width. Each tab should be wide enough to accommodate the label, including translations. However, if the widths are similar, we recommend making them equal.
• Do not use scrolling functions inside a tab
• The number of tabs is limited by the space available in the window, and should not exceed six. If the information does not fit on six tabs, consider another screen design, such as dividing the window into several windows.
• Do not widen the tabs just to fill the width of the tab; instead, leave space at the right side of the tab strip:

![Tab Strip Example](image)

**GUI Attributes**

For each tab in the tab strip:

- Tab label
- Mnemonic
- Description text
- System information

**Functional Specifications**

**Operation Procedure**

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>Description Text is displayed in the status bar</td>
</tr>
<tr>
<td>Choose a tab</td>
<td>The chosen tab is activated.</td>
</tr>
<tr>
<td></td>
<td>The page content is replaced by the content of the active tab.</td>
</tr>
</tbody>
</table>

**Keyboard Shortcuts**

Pressing `Alt+<letter>` switches to the tab represented by this mnemonic.

**4.7.2 Nested Tab Strip**

Usage Example: Sales – A/R → Sales Order → Form Settings window
When to use?

- When a page in a tab strip has too much information to be displayed on one tab, or it contains several sets of information which are not related
- We do not recommend a nested tab strip design. Use it sparingly, with no more than one nesting level. Never nest a tab strip within another nested tab strip.

General Description
A tab strip control that is nested within a tab of another tab strip.

Visual Specifications
- Just like the tab strip, except for the shape of nested tabs (see Tab Strip)
- Active tab:
- Inactive tab:

GUI Attributes
Same as for tab strip. For each tab:
- Tab label
- Mnemonic
- Description text
- System information

Functional Specifications
Same as for tab strip.

Keyboard Shortcuts
Same as for tab strip.

4.7.3 Drawers

Usage Example: Financials → Chart of Accounts

When to use?

- When the information in a window is divided into several subjects
- We do not recommend using this control. It is preferable to divide a window with a tab strip.
General Description

- The control resembles a set of drawers. Each drawer represents a set of information. The information contained in an open drawer is displayed in the window.
- Users navigate between the drawers by choosing the drawer they want to open.
- Each drawer has a unique label. It is essential that this name be short and meaningful, ideally one word.

Visual Specifications

- Only one drawer is open at any given time:
  - Open:
  - Closed:
- Drawers can be stacked vertically (recommended) or placed horizontally beside each other.
- Vertical drawers should be placed on the left side of the window.
- Horizontal drawers should be placed in the top-left corner of the window.
- The drawer label is centered.
- Font: Tahoma 7
- Text color: black

GUI Attributes

For each drawer:

- Label
- Description text
- System information

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>Drawer description text is displayed in the status bar</td>
</tr>
<tr>
<td>Choose a drawer</td>
<td>The drawer is opened and all other drawers are closed. The information contained in the open drawer is displayed in the window.</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts

None
4.8 Window Controls

4.8.1 Window Title Bar

When to use?
As a title bar appearing at the top of each window.

General Description

- A bar at the top of each window; displays the window name and provides standard window management options
- The window title bar contains the following elements:

  - Window Name: States the function of the window
  - Minimize button: Minimizes the window. A minimized window appears in the lower-left corner of the main window, with only the caption visible:

    ![Minimize Button](image)

    When a window is minimized, the minimize icon in its caption is replaced by a restore icon. Clicking the restore icon restores the window’s original size.

  - Maximize icon: Maximizes the window. The window is enlarged to occupy the whole work area of the main window. When the window is maximized, the maximize icon in its caption is replaced by a restore icon. Clicking the restore icon restores the window’s original size. The maximize icon is optional, and does not appear in all windows.

    ![Maximize Button](image)

    Use the maximize icon for windows that benefit from enlargement. Windows that contain data tables must have a maximize icon, because maximizing such windows lets the user see more data.

  - Close icon: Closes the window. If any data was modified in the window, the application issues the message, “Do you want to save?”
Visual Specifications

<table>
<thead>
<tr>
<th>Window Mode</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Recurring Postings</td>
</tr>
<tr>
<td></td>
<td>Text color: white</td>
</tr>
<tr>
<td>Inactive</td>
<td>Recurring Postings</td>
</tr>
<tr>
<td></td>
<td>Text color: white</td>
</tr>
<tr>
<td>Minimized</td>
<td>1099 Editing</td>
</tr>
<tr>
<td></td>
<td>Text color: white</td>
</tr>
</tbody>
</table>

**Note**

The visual specifications of the title bar may vary on different operating systems. The samples below were taken on Microsoft Windows 2000.

- Font: The font style and size of the title is taken from Microsoft Windows settings (the user may select a font in Windows – Control Panel → Display → Appearance → Item=Active Title Bar).
- Caption height: 23 pixels, by default. Selecting a larger font adjusts the window title accordingly.
- Caption width: For regular windows, the caption takes the full width of the window. For a minimized window, the caption width is 160 pixels.
- The name is located 8 pixels to the right of the left border of the window.
- When the window is minimized, the name is truncated to the size available on the smaller caption.
- If the window width is too narrow to show the full name, the caption automatically gets a Tooltip.

**GUI Attributes**

- Window name
- Tooltip (added dynamically)
- Can be maximized: (Yes/No)
- Window state (Normal/Minimized/Maximized)

**Functional Specifications**

**Operation Procedure**

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover</td>
<td>The button color changes to white</td>
</tr>
<tr>
<td>Click an icon</td>
<td>The button performs its function as described in <em>General Description</em>, above.</td>
</tr>
<tr>
<td>Click window caption and drag</td>
<td>Moves the window to another location</td>
</tr>
<tr>
<td>User Action</td>
<td>System Response</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Click anywhere on the window caption</td>
<td>Makes the window active</td>
</tr>
<tr>
<td>Click anywhere on a caption of a minimized window</td>
<td>Displays the Windows menu</td>
</tr>
</tbody>
</table>

**Keyboard Shortcuts**

- **Esc**: Closes the window
- **Alt** and **-** (minus sign): Displays the Windows system menu. Commands in the menu can be accessed by the down/up arrow keys

**4.8.2 Menu Bar and Dropdown Menus**

**When to use?**

A menu bar always appears on the *Main Application* window. It does not appear in any sub window.

**General Description**

- A menu bar includes a set of entries called menu titles. Each menu title provides access to a dropdown menu composed of a collection of menu items, or choices
- Clicking a menu title displays its dropdown menu.

**Guidelines for Adding a New Command to a Menu**

- Decide which menu is most appropriate for the command, based on the content of the existing menus listed below
- When positioning the menu item, consider:
How often is it used? Frequently used items should be placed before less frequently used items

Where is it used in the workflow? Items that are logically successive to other items should be placed directly below them

Menu Content
The SAP Business One menu bar contains the following horizontally placed pull-down menus.

- **File**: Lists primary operations, such as Close, Save, Page Setup, Print Preview, Print, Send, Export to, Launch Application, Lock Screen, and Exit
- **Edit**: Lists general editing commands, such as Undo, Paste, Cut, Copy, Delete, and Choose All
- **View**: Lists commands that change the view of data in the window, such as User-Defined Fields, System Information, Restore Column Width, and Legend
- **Data**: These menu options are used to manipulate system data. They include Add Data and Find Data, as well as common editing commands pertinent for system data. Add commands to this menu that change data in the system.

  In particular, the Data menu has an Advanced submenu, which contains commands that are related to a specific window (form). We recommend that you first consider other alternatives for placing your command, and only if you fail to find a "standard" location, use the Advanced submenu.

- **Goto**: Lists all the links for the active window. A dynamic menu, it changes according to the currently selected window. Menu options that do not apply to the current window are disabled.

  The Goto menu comprises the following sections:

  o Base document and target document (where applicable)
  o Row operations
  o Other windows that are related to the active one; user operation may require a link between them
  o Reports that are related to the active window
  o Jumps within the window itself

- **Modules**: Lists the same items as the main menu; however, the menu in the Modules menu is complete and cannot be customized. (Items in the main menu itself may not be displayed to all users, depending upon customization).

- **Tools**: Lists general system tools, and also specific tools and parameters per window or field.

- **Window**: Lists commands associated with managing the windows, such as Cascade, Close All, Color, Main Menu, Messages Alert Overview, and Calendar. In addition, this menu contains a list of all open windows.

- **Help**: Lists commands that enable access to help information, such as Context Help, Help Settings, and About SAP Business One.

Menu Operation
By clicking one of the SAP Business One menus in the menu bar, you display a list of menu options.

Menu options are designed with a strip containing icons next to the relevant commands.
The list has related commands that are grouped together. The user can select any enabled menu option from the list to perform a specific task or function. An enabled/active menu option has black text, while disabled/unauthorized menu options have gray text.

Submenus

A submenu is designed to be accessed from a parent menu option, and remains hidden until the cursor hovers over the parent. Submenus are arranged vertically and may be cascaded hierarchically into even smaller divisions.

Note

All system functions must be included in the pull-down menus and/or submenus. Add-ons should be listed within existing pull-down menus.

The following guidelines apply to pull-down menus, submenus and menu options:

- **Menu options:** Both pull-down menus and submenus contain menu options. They should appear whether they are enabled or disabled. A menu option can be displayed in the menu, even though it is not applicable when a specific function is active.

- **Pull-down menus:** Pull-down menus should be in a fixed position, and not be altered per window. This assists the user in navigating and finding menu functions easily.

- **Submenus:** We recommend that the maximum nesting depth for submenus not exceed three levels, since it is rather difficult to find a command if there are too many hierarchic, cascading levels. Submenus should not contain often used functions that belong in the first pull-down menu.

- **Grouping:** Groups should not contain more than seven menu options. Separate groups using submenus or separator lines.

- **Separator lines:** Used for clustering the menu options into distinct groups.

- **Text:** Menu options can consist of several words. In English, they should be displayed in upper case. In other languages, they should appear according to the linguistic rules for upper/lowercase.

- **Icons:** Place icons for menu options, when available, to the left of the menu options:
A “check” (√) icon pertains to every enabled function, for example: the Main Menu command on the Window menu is also used to show/hide the Main Menu.

The icon may also replace the check mark. A selected icon indicates that a function is ON:

- **Shortcut Keys**: Shortcut keys (“accelerator” keys) refer to a combination of keys on the keyboard (such as Ctrl + R) that activate a particular function. A menu option can also have a shortcut key assigned to it.
- **Mnemonics**: Menu options should have mnemonics. Mnemonics contain one letter can be underlined that corresponds to a key on the keyboard for each menu option.
- **Enabled/Disabled Status**: Enabled menu options and submenus have black text. Disabled/unauthorized menu options and submenus have gray text.
- **Submenu Arrows**: Following a menu option, an arrow symbol indicates a submenu. The cascading submenu level is displayed if the menu option is selected.

- **Ellipses**: Use an ellipsis (three dots attached to a menu option) to indicate that clicking the option opens a subordinate window. Do not use blank spaces between the menu option and the first dot. In addition, do not use ellipses in the Modules menu.
Visual Specifications – Menu Bar

- The SAP Business One menu bar, located at the top of the SAP Business One main window, shares the same space with the title bar and the standard Windows buttons (maximize, restore down, minimize, close).

- The following object is used to create the background of the menu bar strip:

- Font: The font used for the menu is taken from the Advanced Appearance window. Open Control Panel → Display → Appearance tab, choose Advanced button and change definitions for Item=Menu.

- Font Color:

<table>
<thead>
<tr>
<th>State</th>
<th>Color Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regular</td>
<td>Grey (#233866)</td>
<td></td>
</tr>
<tr>
<td>Rollover</td>
<td>Light blue (#3D76C5)</td>
<td></td>
</tr>
</tbody>
</table>

- One of the letters in each menu title is underlined and used as a mnemonic for this menu title.

Visual Specifications – Dropdown Menu

- Menu items are left aligned.
- Separator lines are used for clustering menu options into distinct groups.
- The Separator strip is used for related icons:
  - Background color: #EAF1F6
  - Strip width: 22 pixels
- A submenu is accessed with an arrow to the right of its parent menu item.
  - The arrow is indented 5 pixels to the right
  - Arrow size: 5 x 8 pixels

- Background color of the drop-down menu: #EAF1F6

- The height of each drop-down menu is not fixed; it depends on the number of menu items:
  - Each item occupies a strip, the height of which is 20 pixels
  - All the items are indented 12 pixels to the left

- The look of the drop-down menu depends on its state:

<table>
<thead>
<tr>
<th>State</th>
<th>Color</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Font color – black</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Arrow color – black</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Disabled Font color – #8B8F96</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Arrow color - black</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rollover Font color – black</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Arrow color - white</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The strip is colored in dark yellow (#FCDD82)</td>
<td></td>
</tr>
</tbody>
</table>

- One of the letters in each menu item is used as a mnemonic to this item.

**Functional Specifications**

**Operation Procedure - Menu Bar**

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover (no menu is open)</td>
<td>The menu title changes to light blue (#3D76C5)</td>
</tr>
<tr>
<td>Rollover when a drop-down menu is opened (mouse cursor is over a title menu)</td>
<td>The associated drop-down menu is displayed</td>
</tr>
<tr>
<td>Click a title menu (no menu is open)</td>
<td>Displays the drop-down menu related to this title</td>
</tr>
<tr>
<td>Click a title menu (when its drop-down menu is open)</td>
<td>Closes the drop-down menu</td>
</tr>
</tbody>
</table>

**Operation Procedure – Drop-Down Menu**

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
</table>
User Action | System Response
--- | ---
Rollover on an item | The item background changes to dark yellow. If the item has a submenu, its arrow color changes to white and the submenu is displayed.
Choose an item | The menu is closed. The operation associated with the item is activated.

**Keyboard Shortcuts**
- **Pressing** `Alt+<mnemonic>` **of the menu title displays a drop-down menu**
  - **While a drop-down menu is displayed:**
    - **Down Arrow / Up Arrow:** Selects the next/previous item in the drop-down menu
    - **Left Arrow:** Opens the drop-down menu to the left of the currently open menu
    - **Right Arrow:** If the currently selected menu item has a submenu, clicking the right arrow opens the submenu. Otherwise, clicking the right arrow opens the drop-down menu to the right of the currently open one.
    - **Pressing** `Alt+<mnemonic>` **of an item in the open menu activates this item**
    - **If a menu item has a keyboard shortcut, clicking this shortcut activates the menu item. The dropdown menu does not have to be open in this case.**

### 4.8.3 Context Menu (Right-Click Menu)

<table>
<thead>
<tr>
<th>Copy</th>
<th>Form Settings...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row Details...</td>
<td>New Activity</td>
</tr>
<tr>
<td>Gross Profit...</td>
<td>Volume and Weight Calculation...</td>
</tr>
<tr>
<td>Packaging</td>
<td>Opening and Closing Remarks</td>
</tr>
<tr>
<td>Save as Draft</td>
<td></td>
</tr>
</tbody>
</table>

**When to use?**
- Use the context menu in any window to provide access to the most commonly used functions in the window
- Use the context menu in any field to provide functions related to this field.

**General Description**

A context menu is:
• A shortcut to frequently used functions
• Structured like a pull-down menu, and may contain submenus
• Valid in every point in a window or table
• Built automatically, according to commands in the main menu, as follows:
  o **Edit** menu: all active entries
  o **Data** menu: all active entries, except: *Copy from Cell Above, Copy from Cell Below*, and all functions that appear in the toolbar (*Find, Add, Next Record, Previous Record, First Data Record, Last Data Record*).
  o **Goto** menu: all active entries, except for commands that take you within the active form itself (*BP Code, First Row, Last Row, Remarks*).
  o **Help** Menu: *What’s This*
  o A separator line is added between groups taken from different menus

**Visual Specifications**

• Background color: #EAF1F6
• Fonts: The font style and size is taken from the *Advanced Appearance* window. Open Control Panel → Display → Appearance tab, choose Advanced button and change definitions for *Item=Menu*
• Font color: black
• Icons: Display the same icons that appear in the toolbar
• Separator Lines: Use 2 horizontal lines next to each other (1 pixel height for each line). The upper line is #D6DFE8 and the lower line is white, as seen in the example below:

![Menu Example](image)

**Note**

- The context menu is built automatically, according to items in the Main Menu. Do not add other items to the context menu. For information, see [General Description](#).
- Context menus must contain items that are also present in other system locations; therefore, a function must not appear in a context menu exclusively.

**Functional Specifications**

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
</table>
User Action | System Response
--- | ---
Right-click a window or field | Displays the context menu attached to this window or field
Click a menu item | Hides menu and performs the required action

**Keyboard Shortcuts**
- Each menu command has a mnemonic. Clicking the mnemonic while the menu is open activates this command
- Menu commands may have keyboard shortcuts associated with them

### 4.8.4 Toolbar

#### When to use?
Use toolbar icons for only the most important functions. Each icon is also located in a pull-down menu.

**Note**
The toolbar is used only in the SAP Business One main window.

#### General Description
- The toolbar consists of the following button groups: *File, View, Data, Goto, Tools, Window* and *Help*
- Each group contains a set of buttons
- The groups are separated by a space
- The user can configure the toolbar by hiding/showing button groups
- Some of the icons, such as the calendar, have a selected view when active
- When the *Print Layout Designer* is active, its toolbar is shown instead of the main toolbar, to the right of the *Context Help* icon.

#### Visual Specifications
- Toolbar height: 31 pixels
- Background is:
- Icon size: 16x16 pixels
- Icon frame: 23 x 22 pixels
- Horizontal space between two icons: 7 pixels. Horizontal space between two icon groups: 16 pixels:
• The icon graphic styles should be consistent with the icons currently used in SAP Business One. Use simple, clear images and colors, preferably soft colors.

• Each icon should have two color versions: full-color, and 16-color (standard MS colors). Each version should have two icons: Enabled and Disabled.

  When an icon is disabled the fills are variations of gray.

Example: 

GUI Attributes
For each button:
  • Icon
  • Tooltip text

Functional Specifications

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover (enabled icon)</td>
<td>A tooltip and a raised frame are displayed.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td></td>
<td>Form Settings...</td>
</tr>
<tr>
<td>Rollover (disabled icon)</td>
<td>A tooltip is displayed.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td></td>
<td>Base Document...</td>
</tr>
<tr>
<td>Click an icon</td>
<td>The frame is checked.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="" /></td>
</tr>
<tr>
<td></td>
<td>The related command is activated.</td>
</tr>
<tr>
<td>Right-click the toolbar</td>
<td>The toolbar settings that appear determine which</td>
</tr>
<tr>
<td></td>
<td>group of icons is displayed.</td>
</tr>
<tr>
<td></td>
<td>Clicking the “v” sign hides/shows the required</td>
</tr>
<tr>
<td></td>
<td>group.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="" /></td>
</tr>
</tbody>
</table>

Keyboard Shortcuts
None
4.8.5 Window Scroll Bar

When to use?
To scroll the contents of a window.

General Description
Windows scroll bars are automatically added to a window, when the window is too small to show all its contents. This may happen when the user:

- Manually resizes the window
- Selects a large font. The window is resized accordingly, and is then too large to fully fit on the screen.

Visual Specifications
Width of vertical scroll bar / height of horizontal scroll-bar: 18 pixels.

Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize the window, making it smaller than its content</td>
<td>Vertical and/or horizontal scroll bars are automatically added to the window</td>
</tr>
<tr>
<td>Enlarge the window</td>
<td>The scroll bars disappear</td>
</tr>
</tbody>
</table>

Keyboard Shortcuts
None
4.8.6 Tooltip

When to Use?

A tooltip is added in the following cases:

- As a general rule, all icons that appear in the application should get a tooltip, and specifically, then following:
  - All buttons that have no text (see Choose from List, Choose From Tree, Back Arrow Icon, Graph Icon, Insert Image and Clear Image Icons, Link Arrow Icon, Extended Checkbox).
  - All Toolbar icons
- When a control is too short to display its full name (or context), a tooltip is dynamically added to show the full text. Controls that get a dynamic tooltip include: text field, list box, table column headers and cells and window title bar.

Command Buttons may get a tooltip if they are too short to show the full button label, or if the planner added a description to the button.

General Description

Whenever the user rolls over an icon (button/column header), the tooltip is activated and displayed next to the icon. The four types of tooltip are:

- Normal (static) tooltip— a row of text explaining the function of an icon
- Dynamically added tooltip— A tooltip displaying the full text of an object that is too small to include long text
- Target Tooltip: A dynamic name added to buttons, to indicate which object or form is targeted by this button. The Target tooltip is displayed as a second line, after the static tooltip of the button.

For Example: Choose from List Button:

- Description: Planners add descriptions to command buttons to further clarify the function of each button. A button description accompanies a standard tooltip showing the full button name, when the button is too short. In the latter case, the dynamic tooltip enters the first line, while the description takes the second line.

Visual Specifications

- Background color: Light yellow (#FFFFE0)
- Frame: 1 pixel wide, black
- Margin around text: Horizontal: 4 pixels; Vertical: 4 pixels
• Text font: Tahoma 7
• Text color: black

Functional Specifications

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rollover (enabled icon)</td>
<td>After ~ 1.5 seconds, a tooltip is displayed.</td>
</tr>
<tr>
<td>Mouse cursor leaves the icon</td>
<td>The tooltip disappears</td>
</tr>
</tbody>
</table>

4.8.7 Status Bar

When to use?
The status bar is used by many controls to display description text and system information. For details, see the specific behavior of each control.

The status bar also displays system messages.

General Description

• The status bar, which extends the bottom of the SAP Business One main window, contains various text fields.
• The top-left field displays the description text of a control during a mouse rollover. The description text should briefly describe the purpose of the control. For input fields, the description text should also include information regarding the input format and length.
• The bottom-left area displays the system information (formerly known as Debug Information) of the control. This is detailed internal information that is displayed only if the user enables the System Information option in the View menu.

Example: Description Text and System Information:

• The bottom-left field is also used to display the following three types of system messages: Error, Information, and Confirmation. For more information, see System Messages and Message Window.
• The middle of a status bar contains an area for the date and time
• You can display user-specific information on the right side of the status bar by dragging up to 4 different input fields. For example, while processing transactions for a certain vendor, place the name and the telephone number of the contact person in the status bar. The next time you open that window, the relevant fields appear in the status bar.

To drag information to the status bar, use the following method:

a. Open a window that contains fields you want to display in the status bar, for example, Business Partner Master Data.

b. Position the cursor on the required field, and drag it to the right-hand corner of the status bar.

Visual Specifications

• Minimal height: 44 pixels

• The following object is used to create the background:

• Field color: See the specification of read-only fields in Text Field

• Text color: black
5. Graphic Design Guidelines

5.1 Screen Resolution

When you build windows, use a screen resolution of 1024x768. Users can work with this resolution and higher. When you define forms, make sure the window size is not more than 1024x628 pixels, so that it fits within a 1024x768 screen.

5.2 Fonts

The SAP Business One application has a default font. If a user selects another font size and style, all text, including text on controls, changes automatically to the new font. If the selected font is larger than the default font, the size of the controls changes accordingly.

The default font in SAP Business One is Tahoma. There are several usages of font style and color for different elements.

Typical font usage:

<table>
<thead>
<tr>
<th>Element</th>
<th>Font Style and Color</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text in fields</td>
<td>Font: Tahoma, 7, Regular</td>
<td>Item</td>
</tr>
<tr>
<td></td>
<td>Color: black</td>
<td></td>
</tr>
<tr>
<td>Labels (fields, buttons)</td>
<td>Font: Tahoma, 7, Regular</td>
<td>Confirmation List</td>
</tr>
<tr>
<td></td>
<td>Color: #FEF09E</td>
<td></td>
</tr>
<tr>
<td>Group Label</td>
<td>Font: Tahoma, 7, underlined</td>
<td>House Bank</td>
</tr>
<tr>
<td></td>
<td>Color: black</td>
<td></td>
</tr>
<tr>
<td>Main Menu category</td>
<td>Font: Tahoma, 9, Bold</td>
<td>Sales - A/R</td>
</tr>
<tr>
<td></td>
<td>Color: white</td>
<td></td>
</tr>
<tr>
<td>Main Menu item</td>
<td>Font: Tahoma, 7, Regular</td>
<td>Sales Quotation</td>
</tr>
<tr>
<td></td>
<td>Color: white</td>
<td></td>
</tr>
<tr>
<td>Window Title</td>
<td>Font: Tahoma, 9, Regular</td>
<td>Recurring Postings</td>
</tr>
<tr>
<td></td>
<td>Color: white</td>
<td></td>
</tr>
</tbody>
</table>

The user may choose another font style and size in: Administration → System Initialization → General Settings → Fonts & Bkgd tab.

After changing the font size, the whole window is resized automatically to fit the new font.

Note

The result of selecting a larger font is an enlarged window. In extreme cases, the resulting window may be too large to fit screen; therefore, window scroll bars are added.

The only exceptions are the Main Menu, the dropdown menus, and the window titles, for which the system (Windows) font is used. For information, see Menu Bar and Dropdown Menus and Window Title Bar.
5.3 Window Layout

Definition

Forms, usually referred to as windows in SAP Business One, are used to view and manipulate data using GUI controls such as fields, tables, command buttons, and so on.

Note

Other window types, such as the main window and Message Windows, are discussed elsewhere in this document.

Window Shell

Every window consists of the following basic elements:

- Title Bar
- Display Area (with the optional default placement of the OK and Cancel buttons)

The figure below shows a window shell with the default values for its width and height. The gray display area is provided for the insertion of additional control elements.

The background color of the display area: #EAF1F6

Title Bar

The title bar contains the title of the window, and standard window buttons and icons for:

- Minimizing the window
- Maximizing the window
- Closing the window
### Note
Regular SAP Business One windows do not contain a menu bar. Only the main window has a menu bar, from which all application functions can be accessed. In addition, only the main window contains a tool bar.

### Scroll Bars
For information, see [Window Scroll Bar](#).

### Window Size
- Default horizontal value for a window: 518 pixels
- Default vertical value for a window: 373 pixels
- Window proportions: The recommended window proportion is 4 X 3. The height measurement is three quarters of the width measurement.
- Maximum window sizing parameters: 1024x628 pixels
  - We recommend that windows be resizable. Allow resizing when the user will benefit from a larger size. When the window contains a data table, resizing is essential, in order to let the user see more information. If the window contains only simple controls, resizing is less important.
  - If the user resizes a window and closes the application, upon subsequent opening, the former sizing parameters and former placement on the main window display automatically as the default.

### Window Margins
- Within the display area, place buttons and other elements positioned near the border, at least 5 pixels from the edge
- Create equal margins on all 4 edges of the window

### Positioning of Fields in the Window
- Place fields in a window in a consistent way
• Align fields (or labels) to a single reference line, whenever possible, and minimize the number of reference lines.

Example: Rearranging the elements by slightly moving or resizing them can significantly reduce the number of reference lines, resulting in a much “cleaner” window:

![Image of a window with aligned fields]

The number of fields within a window must be limited. There is no “golden number” of fields, but consideration should be given to maintaining the spacing rules defined above. If the window is full, divide it into tabs, or sub-windows.

**Tab Order**

- The field order in the window is from left to right and from top to bottom
- The user should be able to move between fields using the Tab key (or Shift+Tab to move in the opposite order)
- If the fields are organized in two columns, the Tab order is first from top-down in the left column, then from top-down in the second column.

**Grouping Multiple Fields**

Related fields should be grouped together. The following figure shows an example of related fields describing the following properties: Code, Name, Foreign Name, Group, Currency and Federal Tax ID.

![Image of a window with grouped fields]

All fields in a group must have the same width, and the width has to show the total length of the field value.

**Note**

A field must be long enough to display the pertinent value in any language. Fields, checkboxes, buttons, and other elements can be placed in groups.
To emphasize the relationship between fields, the vertical distance between them should be small. For fields within a group use a vertical spacing of 1 pixel.

For fields without any logical association, the vertical spacing must be larger. For these fields, define a vertical spacing of at least 3 pixels.

Each input field should have a label (static text field) on its left side to describe the corresponding field. This label should be placed as close as possible to the input field.

**Note**

The label must be far enough away to leave room for labels in other languages. The label must be long enough to display the pertinent text in any language.

If there are more labels below, they have to be aligned at the left border.

### Separating Field Groups

Field groups should be clearly separated. There are two ways to create field groups:

1. **Leave Space between Groups**

   The horizontal space between field groups should be at least 12 pixels.
The vertical space between field groups should be at least 16 pixels.

2. Dividing Line

A divider is a horizontal or vertical line used to divide the window into logical groups of fields.

- Visual specifications
  - White line, 1-pixel wide
  - A horizontal divider goes throughout the width of the window, leaving a space of 6 pixels on each side of the window.

Labeling a Group

Adding a label above a group of fields ties them into one logical unit. The label adds an explanation to the purpose of these groups.

- Visual Specifications
  - The label is written above the fields aligned to the field labels
• The label is underlined

**Group Box**

A group box is a rectangle drawn around a group of fields, providing a visual indication that these fields are strongly related.

In addition, a group box has a label that explains the general meaning of the fields in the group.

**Visual Specifications**

• The group box is a rectangle, bordered by 1-pixel white lines
• The group label is located inside the box, above the fields, left aligned with the labels of the fields
• The group label is underlined
• The horizontal spacing between the box and the edge of the fields is 5 pixels
• The vertical spacing between the box and the edge of the fields is 5 pixels

**Note**

Do not place a single group box alone in a window/tab page. Do not place a single table by itself within a group box.

### 5.4 Terminology

The following are general recommendations in choosing terminology throughout SAP Business One:

• Consult with the SAP Business One InfoDev team who are responsible for terminology.
• Use the same term consistently, so that the same item is always referred to in the same manner. For example, a sales employee is not a sales rep, even though sales rep is an accepted term.
• Buttons and the Goto menu can have verbs. Window names are descriptive and contain nouns and adjectives. For example, a button can be "Add" but a window title should not include "Add."
• When abbreviations are required, ensure that the abbreviation is correct and that the same abbreviation is used consistently
• Titles should be correct and contain as few words as possible. Since it is often difficult to shorten a title, ensure that the key words are present.
• Terms used should be consistent with SAP terminology wherever possible.

Recommendation
We recommend that you refer to the SAP Business One Glossary to familiarize yourself with SAP terminology. You can download this document from the SAP Business One documentation resource center of SAP Channel Partner Portal (http://channel.sap.com/sbo/documentation).

5.5 Labeling Conventions
Labeling refers to text names, titles, headings, descriptions, questions, and prompts employed in all SAP Business One windows and elements. This section outlines labeling guidelines that should be observed.

• Consult with the SAP Business One InfoDev team who are responsible for UI strings.
• Each control should have a label that concisely describes the purpose of the control.
• Some controls (such as button, checkbox, or radio button) contain the label within the control itself.
• Other controls (such as field and list box) have a label placed on the left side of the control. In this case, a white line is drawn under the label and connects it to the control:

  ![Image of a field label example]

  **Note**
  If the window is to be translated, the label length should be extended by 30% beyond the English text length.

  All field labels are written in #EAF1F6.

Capitalization
The following capitalization guidelines apply for labeling in English

SAP Business One windows and elements utilize either Title Case or Sentence Case styles of capitalization.

Title Case
Title Case means that the first letter of each word is capitalized, except for certain small words. The chart below provides specific grammatical guidelines for capitalization usage for title case.

Example:

- Annual Report
- Quarterly Report
- Monthly Report
- Periodic Report

Use Title Case for the following:
• Toolbar tooltips
• Menu option labels
• Field labels
• Radio button labels
• Table column/row headings
• Window area (without frame) headings
• Window labels
• Pull-down menu labels
• Button labels
• Checkbox labels
• Tab strip labels
• Group box (framed) headings
• Titles of reports and lists
• List box/drop-down list box labels

The following English labeling guidelines apply to windows and elements utilizing the Title Case:

• Do not use punctuation at the end of a label
• Use short, precise, clear wording and terms that can be easily understood by the user. For pull-down menus, use a minimal number of words
• As translated text may require more space than the original language, provide extra space (30%) per label
• With certain elements, such as menu options and buttons, disabled or unauthorized text has a different font color
• Never formulate a label as a question
• Use verbs to state actions and nouns to state the object on which the action is performed
• Labels should be as self-explanatory as possible, but short. If a heading or title is too long to fit the space, edit it to include only the most important information.

Sentence Case

When using sentence case, only the first letter of the sentence or phrase is capitalized. All other words are written in lower case, except for proper nouns.

Example:

Document total is zero. Continue?

Use sentence case for the following types of labeling:

• Messages and prompts (on windows and on the status bar)
• Short descriptions and instructions on a window

The following English labeling guidelines apply to windows and elements utilizing sentence case:

• Use punctuation at the end of a label only if the instruction/description is long, for example, more than one sentence
• Do not use punctuation at the end of an incomplete sentence
• Use short, precise, clear wording and terms that can be easily understood by the user
• As translated text may require more space than the original language, provide extra space (30%) per label
• Never formulate a label as a question, unless it is a prompt on a Question Message Window (such as, “Do you want to save the changes?”)
• Labels should be as self-explanatory as possible, but short. If a heading or title is too long to fit, edit it to include only the most important information.

5.6 Command Buttons

Button Positioning
• The main action buttons of a window are placed near the lower-left corner of the screen. This button group usually includes: OK/Cancel/Update/Add, and so on.
• Additional action buttons are located next to the bottom-right corner of the screen
• The buttons should be placed 5 pixels away from the edges of the window
• The distance between two buttons: 5 pixels.

Button Size
• All buttons throughout the system should have the height of 20 pixels
• The length of the button should be long enough to leave space around the text. At least 10 pixels should be left on each side of the text. When calculating the button width, calculate an additional 30% above the English text size, to leave room for translations.
• Button sizes should be consistent within a window. If two buttons are similar in size, make them equal.

Inactive buttons
When a button is not available, due to a specific situation, this button should be disabled. For example, the Edit button is not available until an object is selected. However, if a button is never available because the user is not authorized to use it, the button should be removed from the window.

5.7 Arranging the Information in a Window

Windows may contain many field controls. These elements should be arranged so that they:
• Are clear
• Are understandable to the user
• Conform to the typical workflow
To achieve these goals:

- Divide the information into logical groups
- Arrange the groups and the fields within the group in a clear manner
- Arrange the groups and the fields within the group in an order that matches the workflow. A typical work order in a window is top-down and left to right. Check whether this order matches the way the user works.

When the window must contain a lot of information, it is preferable to divide this information into several views, in the following manner:

- Divide the window (or part of the window) into several tab strips
- Move some of the information into sub-windows.

**Tab Strip Views:**

- Useful for random access, but not for sequential access
- Easy to handle, the user remains within the scope of one window
- Allows quick access of all views; therefore, suitable for situations where the user needs to move frequently between the views

Usage Example: Administration → System Initialization → General Settings.

- Other mechanisms, although less recommended, such as radio buttons or list box may be used as a substitute instead of tab strips.
Sub-Windows:

- Move secondary information into a sub-window
- Accessed via a command button that opens the secondary window
- Ensure that all the basic data is kept in the main window. Move the more advanced data into the secondary sub-window(s).

Usage Example: Sales Opportunities → Sales Opportunity.
• Sub-windows may be used to elaborate a row in a table:

Usage example: Administration \(\rightarrow\) Setup \(\rightarrow\) Financials \(\rightarrow\) 1099 Table.

Each row in this table is expanded into multiple lines in the sub-window. Expanding the row can be performed as follows:

• By double-clicking a row
• By choosing a command (1099 Boxes in the above example) from the context menu
• By clicking the elaboration button (1099 Boxes in the above example) at the bottom of the screen
6. Typical Screens

6.1 Add/Find Window

**Purpose**

This type of window is commonly used for viewing, finding and adding records of data.

**When to use?**

To search for data records, edit records, or add new records.

**Screen Layout**

*Add Mode* screen layout:
Find Mode screen layout:

The Add/Find window contains the following elements:

- Title bar
- Fields of various types
- One of the top fields is the identifier of the object displayed in the window. In marketing documents the identifier always appears in the upper-right corner of the window:

Usage example: Sales A/R → Sales Quotation.
In other windows, the identifier is not necessarily in that corner, but it should be located in the top row:

Usage example: Business Partners → Business Partner Master Data.

- Buttons at the bottom of the Add/Find window start with the Add/Find/OK/Update button followed by the Cancel button on the same line, right justified.
- There is a different visualization for the Find mode. In order to differentiate and prevent user mistakes the search field in Find mode is yellow (#FAF9C3).

The Add/Find Window Modes

The window has four working or operation modes:

- Add: Add a new record
- Find: Search for records of data items
- View: View an existing record
- Edit: Modify the data of an existing record

Operational Procedure

- The Add/Find window appears with the identifying field (item no., code.) in focus
- The Add/Find window does not have a fixed default opening state. It can be opened either in Find mode or in Add mode. The decision regarding the opening state depends on the specific scenario or business case.
- Changing between the Find/Add/View modes of the window can be done as follows:
  - Using the relevant action from the toolbar:
    - Find mode
    - Add mode
  - Using the relevant command from the menu
  - Using the keyboard shortcut:
    - Ctrl+A: change to Add mode
    - Ctrl+F: change to Find mode
• Changing to the Update (Edit mode) is done from the View mode by changing a data item in any of the fields of the Add/Find window.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Main Button Caption</th>
<th>Can Change to Modes…</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>Find</td>
<td>Add, View</td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>Add</td>
<td>Find, View</td>
<td></td>
</tr>
<tr>
<td>View</td>
<td>OK</td>
<td>Edit, Find, Add</td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>Update</td>
<td>Edit, Find, Add</td>
<td>Changes are lost if not updated.</td>
</tr>
</tbody>
</table>

• Navigating between the existing records, for viewing and editing:
  o Goto First record
  o Goto Previous record
  o Goto Next record
  o Goto Last record

Navigation can also be performed via the Goto menu or icon bar.

6.2 List of Values Window (List of <List Type>)

Purpose
This window is opened by the List of Values picker. It allows the user to choose an item from a list.

When to use?
When the user needs to pick a value out of a list, and the selection requires additional information about each item.

Screen Layout

Usage Example: Business Partners → Business Partner Master Data → Shipping Type field → Choose from List.
Title Bar
This is a standard window title bar. The caption is “List of <list name>“, for example: “List of Shipping Types”

Find Field

Purpose
The Find field helps the user locate a value in the table.

Visual Specifications
This is a standard text field. It is the only editable field in the window; therefore it is always in focus (that is, the field is yellow and the insertion cursor is placed at the beginning of the field).

Operational Procedures

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>User types in text in the field</td>
<td>After each character is typed in, the system checks if the content of the field matches the beginning of any item in the list. If a match is found, the first item in the table that has been matched is highlighted.</td>
</tr>
</tbody>
</table>

Items Table

Purpose
The table displays the items from which the user can choose one or more items.

Visual Specifications
- For visual specifications, see Table
- The first column of the table contains the object ID (or key). The table is initially sorted by this ID
- The other columns vary according to the type of selected object. The table should contain between 0 to 4 additional columns. The columns should provide information that helps the user decide which item should be chosen.

Operational Procedure
- Standard operational procedure of a table
- Double-clicking a row performs a Choose operation. The highlighted item is chosen and the window is closed
- The Ctrl and Shift keys are used for selection of multiple items, if relevant.
Items in Tree-Table

Purpose
The user may choose to view the items in a hierarchical format, by defining a group in the Form Settings window.

Visual Specifications

For visual specifications, see Tree-Table Control.

Operational Procedure

- Standard operational procedure of a tree-table
- Double-clicking a row performs a Choose operation. The highlighted item is chosen and the window is closed.

Action Buttons

Purpose
The window contains two to three buttons:

- Choose: Chooses the highlighted item in the table and closes the window. This button is the default button of the screen, meaning that pressing Enter activates it
- Cancel: Closes the window, without saving any selection
- New: Appears only when the list can be edited by the user. Choosing the New button opens an Add Item window, allowing the user to add additional item(s) to the list

When this table view is hierarchical, two buttons are added:

- Expand All: Fully expands the table hierarchy
- Collapse All: Collapses all levels, so that only the upper level is visible.
Visual Specifications

- For visual specifications of each button, see Command Button.
- For specifications of the button positioning, see Command Button.

Operational Procedure

Choosing each button performs the operation as described in the Purpose section.

6.3 Compound Text Field

Usage Example: Sales - A/R → Delivery → Logistics tab → Bill to Compound Text Field.

When to use?

- When it is necessary to store each information section separately
- This control should be used only if there is not enough space to accommodate all the fields.

Example

The address is comprised of different elements (street, city, and so on.) but it is displayed as one text field. When the user wants to edit the information, he does so in the detailed window.

General Description

The edit field looks like a regular field, but when clicked, it opens a new window with the separate elements.

Visual Specifications

- The field looks like any other field.
- The detailed window is built from simple fields.
Functional Specifications

Operation Procedure

<table>
<thead>
<tr>
<th>User Action</th>
<th>System Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clicking a field</td>
<td>Opens the detailed window</td>
</tr>
<tr>
<td>Choosing the OK button in detailed window</td>
<td>Enters the separate text as one piece of text</td>
</tr>
</tbody>
</table>

6.4 Choose from Tree Window

Purpose

This window is used with the Choose from Tree field group. It allows the user to choose an item from a tree structure.

When to use?

To enable the user to insert into a related group of fields information that is built in a hierarchical structure.

Screen Layout

Usage Example: Business Partners → Business Partner Master Data → Payment Terms → House Bank.
Title Bar
This is a standard window title var. The caption is: Choose Object Type.

Items Tree

Purpose
The tree displays the items from which the user chooses one.

Visual Specifications
- For visual specifications of the tree control, see Tree Control
- The tree is displayed in a box colored #D2E1F0
- A scroll bar is attached to the right, if required
- When the window is displayed, the tree is all collapsed, that is, only the root node is visible.

Operational Procedure
- Standard operational procedure of a tree, see Tree Control
- Double-clicking a leaf node performs a Choose operation. The node is chosen and the window is closed.

Action Buttons

Purpose
The window contains 4 buttons:
- **OK**: Chooses the highlighted leaf node in the tree and closes the window. If no leaf node is currently selected, the window is closed without choosing a node. This button is the default button of the screen, meaning that pressing Enter activates it.
- **Cancel**: Closes the window without saving a selection
- **Expand**: Expands the whole tree
- **Collapse**: Collapses the whole tree; only the root node remains visible

Visual Specifications
- For visual specifications of each button, see Button
- For specification of the button positioning, see Command Buttons

Operational Procedure
Choosing each button performs the operation as described in the Purpose section.
6.5 Date Selection Window

Purpose

This window is opened when the user clicks the Date Picker. It allows the user to choose a date from a calendar and return it to the field. For more information on Date picker, see Pickers.

When to use?

To enable the user to pick a date and enter it in the field/cell.

Screen Layout

Usage Example: Sales A/R \to Sales Quotation /Document Date field.

Calendar

Purpose

The calendar displays the current month and/or the field's default month.

Operational Procedure

• Every enabled Date field in the application is accompanied by a Date Picker icon that is located inside the right side of the cell and is visible whenever the cursor is inside the cell.

• When user clicks this icon or uses the shortcut Ctrl+Shift+D while standing in the Date field, the Date selection window is opened.

• This form opens like a list box, beneath the Date field, graphically connected to the field. When there is no option to open the Date selection window below the field, it opens towards the top.

• By default, the first day of the week is Sunday or Monday, based on the localization.

• When selecting the holidays, the value in the "First day of the week" would be set according to the weekend defined in the holiday table.

• Weekends and Holidays, as defined in the Holiday Dates in Company level (link from the Accounting Data tab in the Company Details window), are signed in the Date Selection window.

  In cases where the date should be reflected by the customer holidays (Due Date), SAP Business One chooses the correct dates, although those dates will not be highlighted in the Date Selection window.

• The user can change the month and/or the year and select a date.
• Changing the month or year is possible by using the list boxes of Month and Year and by pressing the arrows icons. Clicking the arrow button moves the current month backwards or forwards. Clicking the arrow when month is on January/December also changes the year accordingly.

• Clicking on the date or using the Enter key closes the form, and the specific date updates the Date field.

• Font Size – *Date Picker* is reflected by the application's font size as selected by the user.

• Note that some manual enhancements may be required to adjust the Date field in cases where it becomes too narrow and hides the actual date.

### Action Buttons

**Purpose**

Each date functions as an action button: When the user clicks on a date it becomes selected and the value is displayed in the field/cell.

**Visual Specifications**

- Current date is highlighted by a blue frame
- Default date is highlighted by a yellow background
- Font Size – *Date Picker* will be reflected by the application’s font size selected by the user.

**Operational Procedure**

Clicking each date performs the operation described in *Purpose*, above.
6.6 Calculator Window

Purpose
This window is opened after the user clicks the Calculator Picker. It allows the user to calculate values and enter them into the field/cell. For more information on Calculator picker, see Pickers.

When to use?
On every numeric field, to provide the user with the ability to calculate without using an external tool.

Screen Layout

Usage Example: Sales A/R → Sales Quotation / Quantity Cell.

Display Field
Displays the result.

Numbers and Functions
Each number and function is an action button.

6.7 Filter Table Window

Purpose
This window is displayed by the Filter Table command available in the menu of most tables. It allows the user to define the filtering criteria of a table, that is, to filter the rows of the table by any combination of the table fields.
When to use?

- Use the Filter Table command (and window) for any table the user may need to filter
- Limitations:
  - You cannot filter a hierarchical table (see Hierarchical Table)
  - You cannot filter tables in marketing documents.

Screen Layout

The Filter Table window is displayed on top of the original window.

Usage Example: Reports → Business Partners → My Activities → Filter Table.

Note

The table currently used in the Filter Table window does not match the SAP Business One standards for tables.

Position

The Filter Table window is displayed on top of the original window.

Title Bar

The title of the window is Filter Table.

The Filtering Criteria

- The window contains a table of filtering criteria, in which each row represents a field in the filtered table
• The first column, *Field*, contains the name of a field (column) in the table

• The second column, *Rule*, contains a list box, from which the user selects how to filter this column. The list box contains (all or some of) the following 11 filtering rules:

<table>
<thead>
<tr>
<th></th>
<th>Equal &lt;value&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Not Equal &lt;value&gt;</td>
</tr>
<tr>
<td>3</td>
<td>In Range &lt;value&gt; to &lt;value&gt;</td>
</tr>
<tr>
<td>4</td>
<td>Out of Range &lt;value&gt; to &lt;value&gt;</td>
</tr>
<tr>
<td>5</td>
<td>Greater Than &lt;value&gt;</td>
</tr>
<tr>
<td>6</td>
<td>Greater or Equal &lt;value&gt;</td>
</tr>
<tr>
<td>7</td>
<td>Smaller Than &lt;value&gt;</td>
</tr>
<tr>
<td>8</td>
<td>Smaller of equal &lt;value&gt;</td>
</tr>
<tr>
<td>9</td>
<td>Is Empty</td>
</tr>
<tr>
<td>10</td>
<td>Is Not Empty</td>
</tr>
<tr>
<td>11</td>
<td>No filter or Combo Box</td>
</tr>
</tbody>
</table>

• The last two columns, *Value* and *To Value* become enabled depending on the selected rule. If the rule requires a value (as in “Greater Than”), the *Value* field becomes enabled. If the rule requires two values (as in “In Range”), both the *Value* and the *To Value* fields become enabled. The user types in the value(s) by which he wishes to filter.

• The *Value* and *To Value* fields contain a special control: It is a list box but it can also be editable. You need to select an empty row and type in a value, and the control functions as a list box. The list contains all values that exist in the relevant column.

• Here are the rules that should be active for each type of column:

<table>
<thead>
<tr>
<th>Column Type</th>
<th>Active Rules</th>
<th>List Box Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Equal</td>
<td>Select or Edit</td>
</tr>
<tr>
<td></td>
<td>Not Equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In Range</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out of Range</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Greater Than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Greater or Equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is Empty</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is Not Empty</td>
<td></td>
</tr>
<tr>
<td>String</td>
<td>All</td>
<td>Select or Edit</td>
</tr>
<tr>
<td>Column Type</td>
<td>Active Rules</td>
<td>List Box Type</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Money / Quantity</td>
<td>Equal</td>
<td>Select or Edit</td>
</tr>
<tr>
<td></td>
<td>Not Equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In Range</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out of Range</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Greater Than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Greater or Equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is Empty</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is Not Empty</td>
<td></td>
</tr>
<tr>
<td>Date/Time</td>
<td>Equal</td>
<td>Select or Edit</td>
</tr>
<tr>
<td></td>
<td>Not Equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In Range</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out of Range</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Greater Than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Greater or Equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is Empty</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is Not Empty</td>
<td></td>
</tr>
<tr>
<td>User type (such as Duration field in Activity form)</td>
<td>Equal</td>
<td>Select or Edit</td>
</tr>
<tr>
<td></td>
<td>Not Equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>In Range</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Out of Range</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Greater Than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Greater or Equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is Empty</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Is Not Empty</td>
<td></td>
</tr>
<tr>
<td>Valid Values (such as Activity field in Activity form)</td>
<td>Equal</td>
<td>Select</td>
</tr>
<tr>
<td></td>
<td>Not Equal</td>
<td></td>
</tr>
<tr>
<td>Checkbox</td>
<td>Equal</td>
<td>Select (Yes/No)</td>
</tr>
<tr>
<td></td>
<td>Not Equal</td>
<td></td>
</tr>
<tr>
<td>Icon</td>
<td>Equal</td>
<td>Select (Yes/No)</td>
</tr>
<tr>
<td></td>
<td>Not Equal</td>
<td></td>
</tr>
</tbody>
</table>
Action Buttons

- **Filter** – filters the table according to the specified filtering criteria
  - After filtering, the Filter button changes to OK. Choosing the OK button closes the Filter Table window.
  - If the user changes any of the filtering criteria, the OK button reverts to Filter.
- **Clear** – clears all filtering criteria
- **Cancel** – closes the Filter Table window, and cancels the filtering in the table.

When the Filter Table window is re-opened, it remembers the last filtering criteria used for this type of table.

### 6.8 Sort Table Window

#### Purpose

This window is displayed by the Sort Table command available in the menu of many tables. It allows the user to define multiple sorting criteria of a table.

#### When to use?

- Use the Sort Table command (and window) for any table the user may need to sort by multiple fields
- Limitations:
  - You cannot sort a hierarchical table
  - You cannot sort tables in marketing documents

#### Screen Layout

The Sort Table window is displayed on top of the original window.

#### Position

The Sort Table window is displayed on top of the original window.
Title Bar
The title of the window is *Sort Table*.

Sort Criteria
- The window contains a table of sorting criteria
- The first column, *Column*, contains a list box. The list box contains the names of all fields (columns) in the table to be sorted, allowing the user to choose a field to sort by.
- The second column, *Order*, contains a list box with two options: *Ascending* or *Descending*.
- The user selects a field in the first column, and then selects its sort order in the second column. In each row a different field can be chosen; there is no limitation on the number of sorting fields. The table is first sorted by the field in the first row, then the second, and so on.

Action Buttons
- *Sort Table* – sort the table according to the specified sorting criteria
- After sorting, the *Sort Table* button changes to *OK*. Choosing *OK* closes the *Sort Table* window
- If the user changes any of the sorting criteria, the *OK* button reverts to *Sort Table*.
- *Cancel* – closes the *Sort Table* window
- *Restore Default* – Restores the default sorting of the table

6.9 Setup Window (NOE = New Object Entry)

Purpose
This window is used to define lists of values, typically used in the Setup folder of the *Administration* module, as well as with list box and *Choose from List* controls.

When to use?
Create a *Setup* window for each list of values that can be defined by the user.
Screen Layout

Usage Example: Administration → Setup → Business Partners → Countries.

Title Bar
This is a standard Window Title Bar. The caption is: “<Object Type> - Setup”.

Setup Table
The table contains at least one column, listing the name of the defined object. Additional columns may be added according to the need for the defined objects.

In the example above there column headers: include Code, Name and so on.

Operational Procedure
The user:
- Clicks in a row (either an existing row or the first empty row)
- Enters value(s), and then chooses the Update button
- Chooses the OK button to close the window

Action Buttons
The window contains two buttons:
- OK/Update: When the window is displayed the button label is OK. After the user types in a value in a row, this button is labeled Update. Clicking it saves the newly added value, and the button reverts to OK.
- Choosing OK saves the table and closes the window
- Cancel: Closes the window without saving the data
- Elaboration button (optional) – see below
Elaborating a row in a setup table:

- In some Setup forms, a row may be expanded into a multi-row table. In this case, sub-windows are used:

Usage example: Administration → Setup → Financials → 1099 table.

In this case, an additional button is added at the bottom-right corner of the window:
- This button is used to open a sub-window containing the elaboration of the selected row
- The name of the button should clearly state what data it elaborates (1099 Boxes in the above example)
- The button is enabled when a row is selected in the table, and disabled when no row is selected

Expanding a row can be performed by:
- Double-clicking the row
- Choosing a command (1099 Boxes in the above example) from the context menu
- Choosing the elaboration button (1099 Boxes in the above example) at the bottom of the screen
6.10 Form Settings

Purpose
This window is used to customize the content and behavior of windows in the system. Each window may be associated with a Form Settings window.

The Form Settings window is accessed via the Form Settings icon in the toolbar (while the customized window is open). It can also be accessed from the Tools menu.

When to use?
Create the Form Settings window for each window that can be customized by the user.

Screen Layout

Title Bar
This is a standard Window Title Bar. The caption is: "Form Settings - <Name of window>".

Definition Area
The definition area may vary, depending on the content of the customized window.
A typical Form Settings window is divided into three tabs:
Table Format (seen in the figure above)
In this tab, the user defines which columns will appear in the table (for a window that contains a table). The Form Settings table contains all the available fields. Selecting the Visible checkbox makes the field appear in the table. Selecting the Active checkbox makes the field editable. The Active checkbox is enabled only if the Visible checkbox is selected for this field.
To change the order of columns, the user clicks and drags a row up or down in the table. During dragging, the cursor changes to a rectangular shape. Only visible fields can be dragged.

**Row Format**

In this tab, the user defines which fields appear in the *Row Details* window associated with the table in the customized window.

The *Form Settings* table shows all available fields. Selecting the *Visible* checkbox makes the field appear in the *Row Details*. Selecting the *Active* checkbox makes the field editable. The *Active* checkbox is enabled only if the *Visible* checkbox is selected for this field.

To change the order of fields, the user clicks and drags a row up or down in the table. During dragging, the cursor changes to a rectangular shape. Only visible fields can be dragged.

**Document**
This tab is used for general settings in the customized window. It typically comprises two nested tab strips:

- **General**: For general window settings
- **Table**: For general settings related to the table in the customized window.

![Note]

The settings in the *Document* tab affect only the current document, and not all documents of this type.

**Action Buttons**

The window contains three buttons:

- **OK**: Saves the changes and closes the window
- **Cancel**: Closes the window without saving the changes
- **Restore Default**: Restores the original window settings and discards all user customization.

### 6.11 Row Details

**Purpose**

A window used to view/edit details of a row in a table.

**When to use?**

The *Row Details* window is usually used in marketing documents to extend the details of an item shown in a table, even when the original details are not displayed in the table.

The window is opened by double-clicking the row header of the required item, or by selecting the *Row Details* command from the context menu or from the *Goto* menu.
Screen Layout

**Title Bar**
This is a standard *Window Title Bar*. The caption is: "*Row Details - <object name>*".

**Row Selector**
The row displays the information: Row <x> of <y> rows. The UP/DOWN dark black arrows change the display to the next/previous row in the table.

**Row Fields**
All fields related to the item are displayed on top of each other. The fields may be editable or read-only. If the fields are editable, the user may change their value. Once you exit the field, the new value is reflected in the table.

All fields are of the same size.

**Note**
There is no *OK/Update* button in this window. The new data is automatically uploaded.
6.12 System Messages and Message Window

Purpose
When the system detects an error or information that generates a message to the user, or when the system requires a user decision in order to proceed, it displays a message. The message is displayed either in the status bar or in a window, depending on the type of error or information. The message states the problem and may offer a solution, so that the user can proceed without external assistance.

When to use?
Use a message box (rather than the status bar) when:

- The message is critical and you want to ensure that the user sees it
- The action cannot proceed without user intervention or decision. In this case a Question Message is displayed.

Screen Layout

Visual Specifications

- Standard message window size: 440x180 pixels
- Use a different size only when no other solution can be found, but try to keep the same proportions.
- Position the system message window in a fixed place in the middle of the screen; however, the message can be moved by the user.
- Use a title bar with the text: System Message
- There are no minimize/maximize buttons on the title bar
- Align the title to the left
- Locate the close button (x) on the right of the title bar
- Fonts:

<table>
<thead>
<tr>
<th>Title</th>
<th>Tahoma, bold, size 8; Color: white</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Body</td>
<td>Tahoma, regular, size 7; Color: black</td>
</tr>
</tbody>
</table>
Message Text

Specifications

- Align message text to the left
- Horizontal position: Locate the text 9 pixels from the left window border
- Vertical position: Locate the text vertically at the middle of the window.

Message Text - Guidelines

- Consult with the SAP Business One InfoDev team who are responsible for terminology.
- The message text should be clear and concise, and should use terms that are easily understood by the user. Do not use technical jargon or system-oriented information.
- Include a problem description and precise instructions for correcting the error. Ensure that the instructions include exact field names and that the required steps are as simple as possible.
- Provide a specific message for each condition.
- Phrase the questions so that their answers fit the standard Yes, No or Cancel browser buttons.

Message Types

The messages can be classified according to different types. The message type determines where the message is issued and how the system responds.

Information Message

Information messages are displayed in the status bar or as popup messages.

The information message informs the user about an issue that does not prevent the procedure from continuing. When the user must acknowledge the message, display information messages in a popup window. The user can continue the processing by choosing OK or ENTER.

Example: “No matching records found” messages (when a report is activated)

Question Message

- Question messages interrupt the processing and require the user to make a choice. Display information messages in a popup window. State the message in the form of a question and provide a button for each response. Phrase the question so that the answer can be Yes or No.
- Some situations may require offering the user not only a choice between performing or not performing an action (a yes/no option), but also an opportunity to cancel the process altogether. In such situations, use the Cancel button. In order to prevent mistakes, try to avoid this situation.

Example: “Do you want to save the changes?”

Error Message

When the system detects an error, use error messages to display significant information for the user. Error messages state the problem and may offer suggestions for correcting the error.

- Display error messages in the status bar or as popup messages.
When the user must acknowledge the message, display information messages in a popup window. The user can continue the processing by choosing OK.

Example: “Field must contain a value.”

Other Messages
There are other types of message windows (for example: Print Options Message) which are not system messages, and are not covered in this chapter.

Status Bar Messages
Three types of messages are displayed in the status bar:

- Error Message: Displayed when a procedure cannot continue until a specific action occurs
- Information Message: Displayed for information purposes. It informs the user about an issue that does not prevent the procedure from continuing.
- Confirmation Message: The message has no influence on the user’s work. It only informs about the successful execution of system functions.

Visual Specifications

Error Message:
- White text over red background + icon
- Background color: red (# FF0000)

Information Message:
- White text over blue background + icon
- Background color: light blue (#9FB1CB)

Confirmation Message:
- White text over green background + icon
- Background color: light green (#7FB67B)

Popup Messages
- Use a popup message (as opposed to status bar) when the message is critical and you want to ensure that the user sees it, or when the action cannot proceed without the user’s intervention or decision.
- Popup message windows should be modal, meaning the user cannot access any other window until the popup message is closed.

For more information, see the specifications for System Messages and Message Window.
Icon

- Icon size: 22x22 pixels
- Locate the icon in 304x34 (left upper corner)
- Use different icons for:

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information Message</td>
<td><img src="image1.png" alt="Information Icon" /></td>
</tr>
<tr>
<td>Question Message</td>
<td><img src="image2.png" alt="Question Icon" /></td>
</tr>
<tr>
<td>Error Message</td>
<td><img src="image3.png" alt="Error Icon" /></td>
</tr>
</tbody>
</table>

Command Buttons

- Use only command buttons that are the appropriate responses or choices offered to the user.
- For Information and Error message use the OK button.
- For question messages, use the following buttons:
  - Yes: Approves the question
  - No: Gives negative answers to the question. Use the No button as a default button when the action the user performs is critical.
  - Yes to All (optional) – Approves the question for the current object in question, and all the following ones.
  - No to All (optional) – Rejects the question for the current object in question, and all the following ones.
  - Cancel (optional): Cancels the action.

**Note**

There is sometimes confusion between No to All and Cancel but these two actions are not the same. Suppose an action is performed on a group of objects. Some of them cause a condition that raises a question for the user. Choosing No to All rejects the action for all those objects that raise the question. But choosing Cancel rejects the action for all the objects in the group, whether they generated a question or not.
Examples

General Guide – Ask Yourself
When creating a message, consider the following:

- Is the message needed?
- Is the message of the right type?
- Is the icon correct for the message type?
- Does the message appear in the correct place (status bar/ popup window?)
- Is the message terminology correct and written in plain English?
- Can the user understand what is required?
- Are the buttons referred to correctly for the options, as written in the message?

6.13 Print Options Messages

Purpose
To offer the user additional print options for specific documents.
When to Use?

The popup Print Options window opens when the user presses the Print button (or Print… in the upper menu) and there are variations of the documents that can be printed.

Screen Layout

![Print Options window](image)

Visual Specifications

Size
- Print Options message window can appear in different sizes according to the number and complexity of the user tasks.
- Optimal proportions are – 2 X 3

Title
- Use the title: Print Options
- Align the title to the left
- Locate the close button (x) on the right of the title bar
- There are no minimize/maximize buttons in the title bar.

Command Buttons

Use the Print and Cancel buttons:
- Print: Approves the options and sends the document to print.
- Cancel: Cancels the print options, closes the Print Options window and returns to the state before the message popped up.
6.14 Report Window

Purpose
A window used to display a report.

When to use?
For each report, use this window to display the report results. This window is typically opened from the selection criteria window.

General Description
- A report window consists of a table displaying a collection of records
- Usually the report Window is preceded by a selection criteria window, in which the user specifies how to filter the data. Only records that match the selection criteria are displayed in the report.
- Within the report window, the user can further filter and sort the data (see Table).
- The Go Back button allows the user to go back and redefine the selection criteria for the report.

Screen Layout

Title Bar
This is a standard Window Title Bar. The caption is <name of the report>.

Data Area
Contains a table with all records retrieved, based on the selection criteria.
Action Buttons
The window has the following action buttons:

- **Go Back**: Closes the window and returns to the selection criteria window
- **OK**: Closes the report and the selection criteria window
- **Cancel**: This button is optional. It appears in reports that can be edited. Cancel closes the report without saving any changes.

Choosing the window’s “X” button closes the report and the selection criteria window.

**Note**
Reports can be filtered and sorted. For more information, see Table.

6.14.1 Hierarchical Reports

**Purpose**
To display a report that contains hierarchical data records.

**When to use?**
Use this window for reports that allow the user to group the report records, thus creating a hierarchy within the report records.

**General Description**
Some reports provide the user with an option to group the resulting report by one or more fields. If the user chooses to do so, a hierarchy is created within the report records.

A hierarchical report may be implemented in two ways:

- Using a hierarchical table (see Hierarchical Table)
- Using a tree-table control (see Tree-Table Control)

**Screen Layout**

Usage Example: Reports → Sales Opportunities → Opportunities Statistics Report.
The Hierarchical Report window is basically identical to a normal report window, except for the following:

- The Expand (.expand) / Collapse (contract) buttons appear within the cell of the parent record.
- If there are several hierarchy levels, each level has its own expand/collapse button in its own cell:

<table>
<thead>
<tr>
<th>#</th>
<th>Item Group</th>
<th>Item No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Games</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>B1</td>
</tr>
<tr>
<td>3</td>
<td>Computers</td>
<td></td>
</tr>
</tbody>
</table>

- If the cell containing the Expand/Collapse button also contains a link arrow, the Expand/Collapse button appears first:

- Two external buttons, Expand All and Collapse All, should be placed at the lower-right corner of the report window, to expand/collapse all rows at once.

### 6.15 Selection Criteria Window

**Purpose**

This window lets the user select the criteria for a report. In this window the user defines:

- Data filtering criteria
- Display options
- Print options

**When to use?**

For each report, start with the selection criteria window, in which the user defines the objects to be included in the report.

**General Description**

- When the user selects a report from the menu, the Section Criteria window is displayed. The selection criteria window contains fields and controls that enable the user to filter the data displayed in the report.
- The OK button in the selection criteria window brings up the report window.
- The report will contain only those records that match the selection criteria: If the user filled a value in a field in the selection criteria window, this field becomes a filtering field, and only records that match its value will be displayed. If, however, a field is left empty – this field has no effect on filtering the report.
- Note that after the report is displayed, the user can filter it further, using the Filter Table command.
Screen Layout

Usage Example: Reports → Financial → Accounting → General Ledger.

Title Bar

This is a standard Window Title Bar. The caption is of the window: <Report Name> - Selection Criteria.

Object Selection

Some reports allow the user to select one of several objects for the report.

There are currently reports that offer this option by using a tab strip control to choose the desired object type:

Selection Parameters

- In this area, the user defines the filtering criteria for the objects displayed in the report.
The selection parameters are divided into two groups (not every report needs both):

- The primary selections, at the top of the window, should include object selection (Customer / vendor / account selection).
- Secondary selection criteria should appear below. These criteria include date selection, as well as other minor filtering options.

Typical selection controls include:

- **Business Partners and Item Selectors**
  This control allows the user to select business partners and items, according to their code, customer/vendor/item group, or Business Partners or item properties:

  ![Business Partners and Item Selectors](image)

  For more details, see [Business Partners Selector and Item Selectors](#).

- **Account Selector**
  This control lists all accounts in a tree format, allowing the user to check accounts (and their sub-accounts) to be included in the report:

  ![Account Selector](image)

  For details about the **Account Selector**, see [Account Selector](#).

- **Properties Selector**
  This control lets the user specify a set of properties. The report includes only those objects that have the selected properties:

  ![Properties Selector](image)

  For details about the **Properties Selector**, see [Properties Selection Field](#).

- **Date Selector**
  Two fields define a range of dates:

  ![Date Selector](image)
• Extended Checkbox:

This control combines several selection options:

- Problem Type

The extended checkbox may appear both as a primary selector (to select Business Partners, for example) or as a date selector. For details, see Extended Checkbox.

Note

In the current version of SAP Business One you may find other, non-standard ways to implement extended selection (for example, a combination of a checkbox with a named command button). Do not use these methods; they are not according to the standards. The Extended checkbox is the only standard way to extend a selection outside the selection criteria window.

Display/Print Options

In this area, place display and print options, separated into two distinct groups:

- Print Each Account on Sep. Page
- Print Directly to Printer
- Order Acct by Chart of Accounts
- Ignore Adjustments
- Foreign Name:
- Summarize Control Accounts

- Display Postings Summary
- Display OB for Periods
- Display: All Postings
- Hide Zero Balanced Acct

This is a modified version of Reports → Financial → Accounting → General Ledger.

Action Buttons

The window has three action buttons:

- OK: Displays the report window. The selection criteria window remains open
- Cancel: Closes the window
- Choose All: Clears all selection criteria that were specified in the window (without any selection criteria, the report will contain all records).

No Records Message

When choosing OK, if the system finds no matching records, the System Message window is displayed: “No matching records were found according to the selection criteria”. The selection criteria window remains open.
6.16 Wizard

Purpose
A wizard is used to assist the user in a complex task, by breaking it into several successive steps.

When to use?
- When the task is too complex to be contained in one window
- When the task involves several steps, which need to be performed in a specific order
- When the task is so infrequent that users may find it hard to learn. Wizards are slower to operate; therefore, do not use them for frequently recurring tasks.
- Not suited for teaching a user how to do something
- It is recommended that a wizard should not be the only way to perform a task. A regular form should be implemented as well.

Screen Layout

Usage Example: *Sales – A/R → Dunning Wizard.*

Screen Size
- Minimal screen size is: 508x390
- When information exceeds this screen size, resizing is only possible upwards. In such a case, the image graphics on the left and right sides of the screen are stretched vertically only. The header and footer should remain constant.
Window Title Bar
- Use a standard *Window Title Bar* with the name of the wizard (Specific Name)
- Align the title to the left
- Locate the close button (x) on the right of the title bar

Header
- The following object is used to create the background:
- Header dimensions (including border line):

The header contains:
- Wizard icon
- Explanation text for the current step

Data Area
- Background color: white
- The data area contains text, fields, controls, tables, and so on, relevant to the current step.
- The data area may contain Action Buttons which are relevant to the current stage. Note that these buttons are separate from the navigation buttons in the wizard footer.

Footer
- The following object is used to create the background:
- Footer height (including border line): 39 pixels
- The Footer contains:
  - Step indication on the left side: Step <step num> of <number of steps> (optional)
  - Text color: black; Font: Tahoma size 10
  - Location: Horizontal: 28 pixels from left edge; Vertical: center of footer
  - Navigation buttons on the right side:
    - Buttons include: *Cancel, Back, Next, Finish*.
      - The *Back* button does not appear on the first page
      - The *Next* button does not appear on the last page
      - The *Finish* button only appears on a page where it is possible for the user to finish the process.
    
    The navigation buttons are active only when navigation is possible, according to the data entry and business case.

Fonts
- For the welcome and name of step, in each screen use Tahoma, size 12; Color: black-bold
- For the explanation text for the step, use Tahoma, size 10, black
Screen Types

The two types of screens are:

- Entry/Exit screen
- Subsequent screen

Entry/Exit Screen

The first page includes a welcoming paragraph which explains what the wizard does.

Subsequent screen

Include on subsequent pages:
• Same graphic, for consistency
• Instructional text
• Controls for user input
• Visual indications that clarify that the graphic is not interactive
• All wizard screens must be of the same size and position.

General Guidelines
• Whenever possible, provide an indication to the user of the current step
• Provide a greater number of simple pages with fewer choices, rather than a smaller number of more complex pages with too many options or too much text.
• Do not require the user to leave a wizard to complete a task
• Include a Finish button at the point where the task can be completed
• The Next and Back buttons should be enabled only when the user is allowed to move forward/backward.
• Make certain it is obvious as to how to proceed when the wizard has completed its process.
• Present a single window at one time
• Do not advance pages automatically
• Keep the same order of buttons all over.

Terminology
The following are general recommendations for choosing terminology in wizards:
• Consult with the SAP Business One InfoDev team who are responsible for the wizard texts and UI strings.
• Do not use technical terms or system-oriented information
• Write simply, concisely, and clearly, following all previously presented guidelines
• Do not exceed three rows for explanations
• Do not overdo instructions. Wizards are not suited to teach users how to do something
• Clearly identify the wizard's purpose in the title bar
• Use a conversational, rather than instructional style
• Use words such as "you" and "your"
• Start most questions with phrases such as “Which option do you want…” or “Would you like…”.
• Include proper welcome and closing text on the first/last page to make the start and end process steps obvious.
7. Adding a New Feature

This chapter lists the issues you should consider when developing a new feature.

Before adding a new feature to the application, clarify the following parameters:

- Importance of the feature
- Expected frequency of usage
- Type and number of potential users

If you decide to add a new feature, locate it according to the above parameters. For example, if the feature will be less frequently used, and not by most users, position it in a sensible but hidden place, so as not to complicate the application for other users.

Form Design

Consider the purpose of the form, and decide on the appropriate window type.

- To add/edit data records, use an Add/Find window (see Add/Find window).
- To define a process, consider a wizard (see Wizard).
- To create a report, design Selection Criteria and Report windows (see Selection Criteria Window).
- To define a value list, use a Setup Window (NOE = New Object Entry).

Choose a name for the form:

- The name should reflect the type of data record that the form will handle.
- Do not use verbs for form names, only nouns and adjectives.
- Consult with the SAP Business One InfoDev team.

Design the content of the form:

- Workflow: Field and control placement should reflect the user’s workflow. Start with the most important items at the top-left corner and advance towards the lower-right. Refer to the Graphic Design Guidelines, for general guidelines of window design (see Graphic Design Guidelines).
- Grouping: Arrange the fields and controls in groups that create a logical connection between the fields. Place groups to create a more pleasant visual arrangement (see Arranging the Information in a Window).
- Visual Arrangement: Ensure that fields and controls are spaced and aligned according to defined standards (see Window Layout).
- Consider what default values should be assigned to fields.
- Terminology: Use clear and short terms, be consistent with similar terms used in other forms, and avoid abbreviations whenever possible (see Terminology).
- Tables: If the form contains a table, consider the following:
  - Select the appropriate table type (simple table, hierarchical, table with row types).
  - Select the column order, so that the most important columns appear first.
  - Is each column really required? Too many columns may reduce table usability.
Extensions to the Form

In addition to the form design, consider how the form is connected to the rest of the application:

- **Menu Location:**
  - Select whether the form should be accessed from the main menu
  - Select the appropriate location in the top menu
  - Position the new entry close to other relevant forms. The order within the selected menu should reflect the importance/frequency of use. See guidelines in [Menu Bar and Dropdown Menus](#).

- **Other links to the form:**
  - Consider whether the feature should be accessed from other forms. If so – add the new feature as a button on the other form, and add a command in that form’s *Goto* menu.
  - Make sure the command (control) that leads to the form is labeled the same as the form name.

- **Links from the form:**
  - When fields refer to other objects – add a link arrow icon that links to that object.
  - Consider if there are other windows relevant to the current form. Add them into the *Goto* menu. See [Menu Bar and Dropdown Menus](#).
  - Consider if any reports are relevant to the current form. Add them into the *Goto* menu. See the [Menu Bar and Dropdown Menus](#).

- **Form Settings:**
  - If you want to let the user customize the window – add a *Form Settings* window.

- **Print Layout Design:**
  - You may plan the print layout.

- **Print Options Messages:**
  - Determine the different printing options See [Print Options Messages](#).

- **System Messages:**
  - Consider if any messages are relevant to the current form. Add them either in the status bar or in a pop up window, depending on the type of the message. See [System Messages and Message Window](#).
Copyrights, Trademarks, and Disclaimers

© Copyright 2011 SAP AG. All rights reserved.

The current version of the copyrights, trademarks, and disclaimers at http://channel.sap.com/sbo/documentation is valid for this document.